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complemented by a comprehensive search facility across all of the accounting modules. 

We have provided this Sage 200 v5.1 Cash Book PDF for your reference only. All of this 
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1
Welcome

Welcome to the Sage 200 Cash Book and to the Sage 200 
Cash Book User Guide.

Sage 200 is a .Net accounting system which offers a 
complete accounting solution to meet your business 
needs.

The Cash Book is one of four Financials modules within 
the Sage 200 Financials Suite.

There are also four Commercials modules, a Bill of 
Materials module and an Accounting System Manager 
module. Each module has its own User Guide. The Price 
Book module is described within the Sales Order 
Processing documentation.

In this chapter:

Using this Guide

What the Cash Book 
offers your business

How the Cash Book 
helps financial 
operations

The bank account 
record 

Chapter summary
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Using This Documentation

The Sage 200 Help system and User Guide provide information on 
how to use the Cash Book. You can access Help for each module 
from the menu bar. You can also press 'F1' on the keyboard to 
display help topics for the screen you are currently working in.

W hope you will find the documentation comprehensive. If you 
want to email us with your comments, please email the Sage 200 
Documentation Team at SageTechnicalAuthors@sage.com and 
mark the subject line as 'Sage 200 v5'.

Process-oriented approach

This User Guide is written to describe the processes that you will 
go through when setting up your ledger, creating bank accounts, 
processing transactions, and controlling purchase debt.

Where the processes comprise of more than one activity, a snapshot 
of activities is provided in the coloured side panel on the first page 
of all chapters. Where it does not, a snapshot is provided of the 
topics included in the chapter.

Conventions

● References to other sections in this User Guide, or to other 
documentation are given in italics.

● References to on-screen items are enclosed in single quotation 
marks. For example, on the 'Contacts' tab, click 'Save'.

● Navigation to a window is illustrated by the name(s) you need 
to choose separated by a symbol >. For example, Choose Cash 
Book Accounts > Account Details means choose the 'Cash 
Book Accounts' option and then the 'Account Details' option.

● Where there are prerequisites to performing activities these are 
indicated graphically using the ✔ symbol so you can easily 
identify them.

For detailed information on the operation of Sage 200 see the Sage 
200 Operations documentation.
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Sage 200 Cash Book

The Cash Book lets you take care of business transactions associated with your bank and cash 
accounts. It provides all the functions to maintain details of your bank accounts and to control 
full multi-currency bank account transaction processing and reconciliation.

You can maintain as many bank accounts as you need, and these can be in any currency. You 
can record cash receipts and payments either for nominal transactions or for posting to the sales 
and purchase ledger accounts. You can allocate receipts and payments to outstanding invoices 
as you can in the Sales and Purchase Ledger modules. Other routines take care of standing 
orders, direct debits and other recurring transactions. Foreign currency processing includes the 
necessary postings of bank charges, commission and exchange rate discrepancies.

All Cash Book accounts can be reconciled against statements to help you keep track of cleared 
and uncleared items, while a range of reports and enquiries provide up-to-the-minute 
information about the activities associated with your Cash Book.

Provided you have obtained the 'Sage e-Banking' facility and then enabled it in the Purchase 
Ledger you can link to your bank’s electronic banking program (provided your bank’s program 
is compatible with 'Sage e-Banking'). This provides the e-Banking facilities to reconcile bank 
statements electronically as well as make electronic bank payments through the Purchase 
Ledger.

What Sage 200 Cash Book offers your business

The Cash Book provides the options you need to control your business finances and transactions 
associated with bank and cash accounts in any currency you choose.

The Cash Book is used to set up details of your bank accounts. You can set up as many bank 
accounts as you need to operate in different currencies provided you have specified the currency 
in the exchange rate table.

To integrate with the Nominal Ledger the Cash Book uses nominal codes. These codes identify 
the nominal accounts used for the bank account, bank charges and exchange rate discrepancies. 
Such accounts are used as defaults when posting payments or receipts within the Cash Book.

Receipts

Receipts can be posted to both the Sales and Nominal Ledgers. You can enter the amount 
received in any currency, and post it to a bank account of any currency. The exchange rates take 
care of the conversion, and the Cash Book records the amounts for bank charges, interest and 
the profit and loss on exchange, if applicable.
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When posting receipts to the Sales Ledger, the appropriate customer account record is accessed 
and a receipt may be posted with or without settlement discount. You can then allocate the 
receipt to outstanding items on the account by using the Sales Ledger 'Allocation' routine.

When posting receipts to the Nominal Ledger, cash income can be recorded between the bank 
account and a specified nominal ledger account, with the transaction optionally including VAT.

Several receipts can be added to the Cash Book at the same time using the 'Grouped 
Transactions' routine.

Payments

Payments are handled in much the same way as receipts. When posting payments to the 
Purchase ledger, the appropriate supplier account record is accessed and a payment may be 
posted to outstanding items. Payment may be allocated at the time of posting to outstanding 
items. 

Nominal Ledger payments involve the bank account and an expense account and you can print a 
cheque immediately after posting nominal payments.

Several payments can be added to the Cash Book at the same time using the 'Grouped 
Transactions' routine.

Direct Debits and Standing Orders

Direct debits and standing orders are recurring bank transactions, including or excluding VAT 
in which a specified amount is paid from the bank account to an expense account in the Nominal 
Ledger for a definite number of periods. The direct debits or standing orders can be processed 
on a monthly or quarterly basis, or if you prefer you can specify a frequency which is more 
suitable to your organisation.

Direct debits are also recurring bank transactions, but the first and last payment amounts may 
differ from the regular payment. Direct debits may be subject to VAT and the frequency of 
payment may be weekly, monthly, quarterly or some other specified period. As with standing 
orders, the necessary payments or receipt transactions can be processed manually whenever you 
want.

Bank Account or Petty Cash Transactions

You can record transactions between bank or petty cash accounts of either the same or different 
operating currencies. If the accounts operate in different currency, the system converts the 
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transactions based on the appropriate exchange rate. You can also record the commission 
involved in the transfer and specify which bank is to pay the commission.

Refunds

Transactions can be reversed to take care of sales and purchase refunds. This is similar to 
posting payments and receipts, except that the reverse entry is made. For example, you may 
want to use it to post details of a cheque refund to a customer and allocate it against a receipt.

Reconciliation

When a bank statement is received, you have the routine to reconcile this with the details of 
payments and receipts of the bank accounts stored in the Cash Book. This can be performed 
manually. Alternatively, provided you have an appropriate electronic banking service and have 
obtained and enabled the 'Sage e-Banking' facility in the Purchase Ledger, you can reconcile 
your bank statement electronically. The statement date is recorded and you can then 
systematically acknowledge individual transactions on the statement with those on the bank 
record and if required enter an amount where the amount differs between the statement and the 
transaction record. You can also add payments and/or receipts at the time of reconciliation to 
make immediate adjustments for items on bank statements, such as bank charges or interest, not 
included in your Cash Book bank account. A report can then be produced which provides details 
of totals of unpresented items and the balance on the account up to the last reconciled 
transaction.

The statement date is then the basis on which individual transaction items can be removed from 
the bank account, leaving a balance brought forward which includes the net figure for the 
account. Thus, all transactions remaining are awaiting reconciliation.

Reports

The Cash Book provides standard reports for you to use immediately. They range from 
straightfoward account listings to detailed analysis of balances, transactions and statement 
reports. You can specify your own criteria to ensure that you get only the information you need. 
You can print your reports to a printer installed in Windows and you can preview reports on 
screen as well as filing them for printing at a later date, if your prefer. For more information see 
your Sage 200 Operations documentation.You can design your own reports too. For more 
information see your Sage Report Designer documentation.

'Period End' routines

The 'Period End' routines take care of a number of activities you would normally carry out at the 
end of each day or accounting period. The Cash Book receives transaction postings from the 
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Purchase ledger for example, when payments are made and remittance advices produced. The 
Cash Book also receives postings from the Sales Ledger. The transactions are stored in the Cash 
Book and are integrated into the appropriate bank account(s).

The Cash Book generates Nominal Ledger postings to the nominal accounts such as the 
exchange discrepancy, bank charges and commission accounts. These postings are listed in the 
'Report NL Postings' report in the Cash Book. The Nominal Ledger 'Update Waiting Postings' 
routine ensures that the postings are transferred to the appropriate nominal accounts.

'Maintain Accounting Periods' in the Accounting System Manager performs a number of 
essential housekeeping functions. For example, it updates the period balance figures of the bank 
account records.

How the ledger helps financial operations

Sage 200 helps you to manage your bank accounts by:

● Providing you with an integrated system of accounting within which you can manage your 
bank accounts and apply your cash information. 

● Providing you with control of your bank accounts at several levels within this integrated 
system.

System integration

The Cash Book is designed to integrate with the following modules. 
          

Integrate with Integrate how

Sales Ledger To post receipts and payments directly to the Sales Ledger 
accounts from the Cash Book. To reverse receipts by posting 
payments.

Purchase Ledger Enable e-banking facilities in the Cash Book by selecting 
'Electronic Bank Payments' in the Purchase Ledger Settings.
Make payments and receipts directly into Purchase Ledger 
supplier accounts from the Cash Book. To reverse payments by 
posting receipts.

Nominal Ledger Send details of purchase values, VAT, discount, and so on, to the 
Nominal Ledger to provide accurate figures for your Profit and 
Loss and Balance Sheet reports. To raise nominal payments and 
receipts.
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Benefits of integration

The main benefit of using an integrated system is that you only need to enter information once, 
in one module, and it is used in the relevant areas. 

Sage 200 automatically handles common data, ensuring the appropriate information is directed 
to the relevant modules. This saves time and reduces the risk of error by removing the need to 
re-enter information.

To pass information between modules in general you need only:

● Ensure that the appropriate account codes match between your modules.

● Select the appropriate 'Update Pending Transactions' within each module and Period End 
process within the Accounting System Manager.

Control of accounts

You can control your supplier accounts through the definition and application of settings at 
three levels within Sage 200.

● Global level

Define settings using Accounting System Manager and the Nominal Ledger. These apply 
throughout Sage 200 and you can apply them within your Cash Book. These settings provide 
the broadest level of control within your Sage 200 system. They help you to define the 
operation of Sage 200 in the best way for your organisation.

● Module level

Apply global settings, and define settings using the Cash Book, which apply when you 
process transactions in the Cash Book. These allow you to specify your preferred bank 
account information when you create new bank accounts and process transactions.

● Account level

Apply module settings, and define settings specific to each account when you create new 
accounts or process transactions in the Cash Book. These are local and unique to each 
supplier account.

          

Note: Global level settings apply within the module. Module level settings apply at the bank 
account level although you can override module level settings on the bank account.
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The Bank Account

The bank account record holds the details that identify a bank account and describe the terms of 
business you have agreed between you and the financial organisation you use. As each bank 
account is created, you can apply an opening balance to each account. This shows how much 
you are in debit or credit with your bank.

There are two types of bank accounts you can create; current or deposit account. You can 
combine the two types of accounts within your Cash Book.
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Documentation Summary

The following is a summary of the remaining sections in this documentation. Appendices hold 
detailed examples and other technical information.

Set Up the Cash Book

This guides you through the setup process for the Cash Book. It describes the settings you can 
use to customise the ledger to meet your company’s needs.

See Set Up the Cash Book on page 11.

Establish and Maintain Bank Account Records

This explains the components of a bank account record and its context within other Sage 200 
modules. 

It describes how to build and maintain accurate bank account records. This includes the 
management of standing orders and direct debits associated with the bank accounts.

It also describes how to set up bank accounts to use electronic banking.

See Establish and Maintain Bank Account Records on page 17.

Manage Transactions

This deals with handling receipts and payments associated with the organisations you trade 
with. It describes how to handle a single transaction or multiple transactions as well as recording 
the transfer of funds from one bank account to another.

It assumes transactions are entered in your base currency. The implications of working with 
foreign currency transactions are dealt with separately (see Manage Foreign Currency 
Transactions on page 63).

See Manage Transactions on page 47.

Manage Foreign Currency Transactions

This builds on the previous section which describes the management of transactions in your 
base currency. The aim is to explain the additional considerations and routines required when 
dealing with foreign currency transactions.
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It also explains the facilities you can use to manage your trade in foreign currencies.

This does not cover EC implications or Triangulation. For more information see your Sage 200 
Accounting System Manager documentation.

See Manage Foreign Currency Transactions on page 63.

Manage Bank Accounts

This deals with the bank account as a whole, covering both the bank account record and its 
associated transactions.

Primarily it deals with the activities you need to perform to keep your bank account balances up 
to date, thereby providing you with accurate and complete cash records.

It also explains the various reports used to manage your bank accounts.

See Manage Bank Accounts on page 87.

Maintain Cash Book

This covers the regular housekeeping routines needed to maintain the efficiency and 
effectiveness of your Cash Book.

It includes the routine used to identify the status of the Cash Book as a whole and covers the 
mechanisms employed to maintain the integrity of the data held in the Cash Book.

See Maintain Cash Book on page 113.

Glossary of Accounting Terms

This includes frequently used Sage 200 accounting terms and their meanings.

See Glossary of Accounting Terms on page 117.

cash book manual.book  Page 10  Tuesday, February 19, 2008  11:02 AM



2
Set Up the Cash Book

This chapter guides you through the setup process for the 
Cash Book. It describes the settings you can use to 
customise the ledger to meet your company’s needs.

          

Note: There is a view only version of the settings 
window in case you need to contact Sage 
Support and provide details of the ledger 
settings. See View Settings on page 15.

Activities:

Plan setup

Set up ledger

View settings
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Before you begin

You must have:

✔ Set your Sage 200 defaults, using the Accounting System 
Manager module. See your Sage 200 Accounting System 
Manager documentation.

✔ Set your default nominal accounts, using the Nominal Ledger. 
Refer to your Sage 200 Nominal Ledger User Guide.

          

Remember ...

For more information on using the help system, see the Sage 200 
Operations documentation.

Note: You must have suitable security privileges to perform 
these activities. See your system administrator for more 
information.
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Plan Cash Book Setup

The setup process builds on and complements the settings within the Accounting System 
Manager and Nominal Ledger. The aim of this process is to tailor the ledger to your company’s 
needs. By doing so it saves you and other users time when using the ledger on a day to day 
basis.

Cash Book settings

There is one setting to make when preparing the Cash Book and it is described below.

Default bank account
          

From your bank accounts you can select the base currency bank account used most frequently 
and set it as your 'Default Bank Account'. This means that each time a transaction is entered 
involving a bank account, the default bank account is always displayed for you. This account 
can of course be overridden when a transaction is recorded on the system if it is not appropriate.

The first base currency bank account created in the Cash Book is automatically assigned as the 
'Default Bank Account'. As more bank accounts are created, use this setting to assign a more 
appropriate 'Default Bank Account', if required.

          

Setup Checklist
          

Note: Setting changes should only be made when there are no users updating the Cash 
Book.

Default bank account..................................................................................................................
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Setup Process

Before you begin ...

You must have:

✔ Planned the Cash Book setup. See Plan Cash Book Setup on page 13.

Access the window

Choose Utilities > Cash Book Settings.
          

Enter the details

● Use the window to activate the setting according to your needs. (Use the Setup Checklist on 
page 13 to keep a copy of the setting you choose.)

Outcomes

The Cash Book is set up for your company’s preferred operation.
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View Settings

This is a view only version of your ledger settings and you will use this option if you need to 
contact Sage Support and provide details of your ledger settings to the support team.

Access the window

Choose Utilities > View Cash Book Settings.

          

Enter the details

● Click 'Close' to close the window.
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3
Establish and Maintain Bank 
Account Records

This chapter explains the components of a bank account 
record and its context within other Sage 200 modules. 

It describes how to build and maintain accurate bank 
account records. This includes the management of 
standing orders and direct debits associated with the bank 
accounts.

This chapter also describes how to set up bank accounts to 
use electronic banking.

Activities:

Create account

Enter opening balance

Rectify opening 
balance

Amend account

Delete account

Set up standing orders 
and direct debits

Amend standing 
orders and direct 
debits

Delete standing orders 
and direct debits
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Before you begin ...

You must have:

✔ Set your Cash Book defaults, using the Cash Book settings 
window. For more information see Chapter 2, Set Up the Cash 
Book.

✔ Created your nominal accounts and specified your default 
nominal accounts in the Nominal Ledger. For more information 
see your Sage 200 Nominal Ledger User Guide.

          

Remember ...

For more information on using the help system, see the Sage 200 
Operations documentation.

Note: You must have suitable security privileges to perform 
these activities. See your system administrator for more 
information.
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Build Bank Accounts

The account record is fundamental to the successful management of bank accounts in the Cash 
Book. Bank account records evolve through a life cycle of creating, amending and deleting, all 
of which are described within this chapter.
          

The account record holds the following key information:

● Contact details.

● Account details.

● If you have enabled e-banking in the Purchase Ledger then it will also hold e-banking 
information on the e-Banking tab.

 

Contact Details
bank name, address, telephone, fax, e-mail,  

web address 

Account Details
sort code, account number, name, currency, 

account type, overdraft limit, 
nominal account codes 

E-Banking Details
e-banking service provider, 

e-banking functions, file locations 

Statement Balances 
(view reconciled 

statement balances)

Bank Account Record

Attachments 
(letters, graphic 
images, e-mails) 

Memo 
(notes about the bank, 
special requirements 
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Planning your bank and cash accounts

You need to set up a bank record for each bank account you intend to use for your business, as 
well as one for each cash account you want to maintain. In fact, Cash Book accounts can be any 
type of account that you receive and pay out money from. 

You can set up a bank account for each of your credit cards too. The Cash Book treats cash and 
credit card accounts in just the same way as true bank accounts. They can be reconciled against 
monthly statements the same way you would reconcile your current bank account against the 
statements sent from your bank.

Since the Cash Book is multi-currency, you can set up a bank account record for each currency 
account you want. For example, if you have a foreign bank account, you can set up the account 
and assign it the correct currency description. All balances for that account can then be stored in 
that currency. It is also possible however, to post transactions of different currencies to any bank 
account, provided an exchange rate between the currencies is specified when the transaction is 
entered onto the Cash Book.

For each bank record in the Cash Book module there must be a corresponding Nominal Ledger 
account record. When postings are made to the Cash Book bank account, the credit or debit 
values are posted to the appropriate Nominal Ledger account in base currency.
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Create a Bank Account Record

This activity is achieved by entering unique bank details onto the window for creating a bank 
account record. Some boxes on the 'Enter New Cash Book Account' window have a set of 
predetermined entries and the account details may only be selected from the valid entries given 
in a drop-down box. This is the case with the 'Account Type' box, for example.

The window used to create the bank record consists of five sections, or tabs: 'Account Details', 
'Contacts', 'Statement Balances', 'Memo' and 'Attachments'. If you enable e-banking in the 
Purchase Ledger, an 'e-Banking' tab is added. Only the first two tabs of the window are used to 
create the bank record, whilst the 'e-Banking' tab is used to configure e-banking for the account. 
While you are creating the account you can attach files and add text memos to the bank account 
record using the 'Attachments' and 'Memo' tabs. Statement balances are maintained by the Cash 
Book as part of the bank reconciliation process. So the 'Statement Balances' tab is not applicable 
until you amend an account after having run the 'Bank Reconciliation' process. For more 
information see Reconcile Bank Account on page 91.

The first base currency bank account created in the Cash Book is automatically assigned as the 
default bank account. As more bank accounts are created, use the Cash Book Settings to assign 
a more appropriate default bank account, if required. For more information see Cash Book 
settings on page 13.
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Account Details tab

The 'Account Details' tab holds the unique details that identify the account as an individual bank 
account. It also holds the characteristics of the account which determine its context with other 
Sage 200 modules and how it operates.

This section of the window also holds dynamic bank information which is maintained by the 
Cash Book. Therefore you cannot add values to the 'Last statement date', 'Current balance' or 
'Base currency balance' boxes.
          

To create a bank account record you must assign both an 'Account ref' and 'Account 
description'. The boxes for these details are in the 'Details' portion of the 'Account Details' 
window.

The 'Account ref' is a unique number that can consist of up to eight characters. How you assign 
the 'Account ref' is entirely up to you, although it is best to plan your coding structure so that a 
procedure for assigning new numbers can be established and adhered to. 

The 'Account description' can consist of up to 30 characters and is used to assign a name which 
you commonly use to refer to the account, for example 'euro Account' or 'Main Bank Account'. 
The account description appears on reports and does not need to be the same as the operating 
name for the bank.
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The 'Sort code', 'Account number' and 'Account name' are all dictated by the bank which holds 
the account for you.

The 'Account currency' determines the operating currency of the bank account. The foreign 
currencies specified in the Accounting System Manager are provided in the drop-down list and 
you can make the appropriate selection from this list. By default the first currency in the list is 
always displayed as your base currency. For more information see your Sage 200 Accounting 
System Manager documentation.
          

The 'Account type' is selected from a drop-down box and the Cash Book provides two types, 
either a 'Current' account or a 'Deposit' account.

The 'Overdraft limit' box holds the value of the overdraft limit you have agreed with your bank. 
If the limit is exceeded, the Cash Book displays a warning when transactions are posted, 
although you can still proceed.

The three 'Nominal accounts' boxes determine how you want your cash transactions posted to 
the Nominal Ledger. When creating a new account the Cash Book automatically displays the 
default nominal 'Bank account' specified in the Nominal Ledger. You can accept the displayed 
default accounts or specify another nominal account. 

If you specify a nominal account which has not been created in the Nominal Ledger any 
transactions posted from the bank account are placed in the nominal suspense account.
          

Note: Once a bank account has transactions posted to it, the currency code cannot be 
changed.

Note: The nominal accounts must be posting type accounts. For more information about 
nominal account types see your Sage 200 Nominal Ledger User Guide.
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Contacts tab

This section of the window holds the contact details for the bank account and are self 
explanatory.

The 'E-mail' and 'Web site' boxes can hold several addresses. It is worth noting that you can 
activate an address entered into the 'E-mail' or 'Web site' box to call up your bank’s website or 
invoke your e-mail send message routine so you can contact your bank, but only if you have 
access to the worldwide web. Alternatively the boxes can be used for notational purposes if you 
prefer.
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Statement Balances tab

'Statement Balances' are maintained by the Cash Book as part of the bank reconciliation 
process. So this tab is not applicable until you amend an account after having run the 'Bank 
Reconciliation' process.

          

For more information see Reconcile Bank Account on page 91.
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Memos tab

This tab allows you to enter text for the selected account.

The text entered here, when saved is stored in a memo file. It can be viewed or updated via this 
'Memos' tab. The 'Date' and 'User' name will be stamped underneath the text entry each time the 
memo is updated.

          

To add a memo click the 'Add' button to open an edit box for you to enter any text you require.

To edit a memo, click 'Edit' to open the existing memo; you may add to or change the text 
already there.

To delete a memo, edit the memo and delete all the text.
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Attachments tab

Files external to Sage 200 but pertaining to a particular bank account can be attached to their 
account record here. This tab allows new associations to be created or allows the viewing of 
files currently attached. The 'Icons' button will change the displayed list of files to icons and file 
name, 'Details' puts it back to a detailed file list.

Any type of file (graphic, Word document or spreadsheet, for example) can be associated with 
an account. This is done by placing the files in a folder/directory, which is linked to the account.

          

To add an attachment, click the 'Add' button. It opens the ‘Add an Attachment’ window. Once 
you have selected the required file, click 'Open'. The selected file will be listed in the 
'Attachments' tab.

To view an attachment double click on the file name in the list or select the file and click the 
'Open' button.

To delete an attachment select the file and then click' Delete'.
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e-Banking tab

This section of the window is where you link the cash book account to the e-banking service.

The e-Banking service is one which you have subscribed to, which supports the activity you 
intend to use (payments and/or reconciliation) and is compatible with 'Sage e-Banking'.

You also enter the activities you want to perform electronically: 'Payments only'; 'Bank 
reconciliation only'; or 'Both payments and bank reconciliation'.

By clicking 'File Locations' you can specify the default directory where your bank import and 
export files are normally stored.
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Enter a new bank account 

Before you begin ...

You must have:

✔ Details of your 'Chart of Accounts'. For more information see your Sage 200 Nominal 
Ledger User Guide.

✔ Enabled e-banking in the Purchase Ledger if you want to use e-banking. For more 
information see your Sage 200 Purchase Ledger documentation.

✔ Subscribed to an appropriate electronic bank service if you want to use e-banking.

          

Note: If you have subscribed to an electronic banking service and enabled e-banking in the 
Purchase Ledger, the first time subsequently that you enter a new account or amend 
an existing account you will be presented with a registration form for your chosen 
electronic banking service. You must register for the electronic banking service by 
entering your user name and password. You will not need to do this again once you 
have registered, even if you switch e-banking off and on again in the Purchase Ledger. 
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Access the window

Choose Cash Book Accounts > Enter New Account.
          

Enter the details

● Using the 'Account Details' tab, enter the 'Account ref' and 'Account description'.

● Specify the 'Sort code', 'Account number', 'Account name', if applicable, and select the 
'Account type' and 'Account currency' from the drop-down lists.

● Enter the agreed 'Overdraft limit' for the account, if required.

● Specify the 'Nominal accounts' to be used for nominal analysis, either accept the default 
nominal codes displayed or enter a different code.

● Enter the nominal account code for the 'Bank account'.

● Enter the nominal account for the 'Bank charges'.

● Enter the nominal account for 'Exchange differences'.
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You must specify posting type nominal accounts. If you enter nominal codes for existing 
group or memorandum type accounts, the routine prompts you to re-select the codes. Until 
you specify codes for a posting type account you cannot continue. However, if you specify 
nominal account codes that do not exist in the Nominal Ledger the routine warns you but 
you can continue to create the account. For more information see your Sage 200 Nominal 
Ledger User Guide.

● Using the 'Contacts' tab, enter the bank’s contact details, if applicable.

● Using the 'e-Banking' tab, select the correct 'E-Banking service' using the 'E-Banking 
service' drop-down list.

● Select the activities you want to perform electronically using the 'E-Banking functions' 
drop-down ('Payments only', 'Bank reconciliation only' or 'Both payments and bank 
reconciliation').

● Click 'File Locations'. The routine displays the bank configuration window which varies 
depending on your bank’s electronic banking program.

          

cash book manual.book  Page 31  Tuesday, February 19, 2008  11:02 AM



Sage 200 Cash Book 

32

● Specify target directories to store electronic payments and statement data.

● If you intend to use one directory for both payments and statement data, enter the 
nominated directory in the 'Common directory' box.

● If you intend to use separate directories for your electronic payments and statement data, 
select the 'Override common directory' check box and specify the nominated directories 
in the 'Statement Reconciliation Service' and 'Payment file options' boxes.

Outcomes

● The bank account record is created.

● If the bank account record is the first base currency bank account, then this is set as the 
default bank account for the Cash Book.

● If you are using 'Sage e-banking', the bank account is enabled for automatic processing 
according to your selections.

Enter opening balances

Opening balances represent the financial position of your organisation on the day you start 
entering live transactions onto your bank account. Whatever date you choose you are likely to 
have opening balances, whether your organisation is just starting up or changing from another 
accounting system. 

You can enter a book opening balance which consists of one value indicating the actual balance 
on the account. Alternatively you have the option to enter a reconciled opening balance which 
consists of one reconciled balance and unpresented entries. The Cash Book calculates the actual 
book bank balance based on the reconciled value and the unpresented items. You will then be 
able to reconcile the unpresented entries as normal using the 'Bank Reconciliation' routine.

An opening balance can only be entered once for an account. If either opening balance routine 
finds the account holds an opening balance type entry a warning appears and you cannot 
continue. Also the system assigns the transaction as type 'OP' (opening balance) and you can 
enter your own reference.

It is possible to rectify an erroneous opening balance. See Rectify an opening balance on page 
35.
          

Note: No postings to other ledgers are made as a result of using the opening balance routine.
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If you enter a book balance for a bank account you should reconcile the bank account before 
entering any bank transactions. This ensures the statement opening balance is updated. For more 
information see Reconcile printed bank statement on page 91. If you enter a reconciled balance, 
the statement opening balance is updated immediately.

Enter book opening balance

Access the window

Choose Other Transactions > Opening Balance.
          

Enter the details

● Select the bank account you want to enter an opening balance to.

● Enter the 'Date' and 'Reference'.

● Enter the opening 'Balance' value (positive or negative) in the account’s operating currency.

● For a foreign currency bank account, accept or amend the 'Exchange rate' displayed, the 
specified rate is used to convert the bank values to base currency.
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Outcomes

● The current balance on the bank account is updated to reflect the opening balance entries 
made.

Enter reconciled opening balance

Access the window

Choose Other Transactions > Reconciled Opening Balance.
          

Enter the details

● Select the bank account you want to enter an opening balance to.

● Enter the 'Date' and 'Reference'.

● Enter the opening bank 'Balance' (positive or negative) in the account’s operating currency.
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● Enter each unpresented entry by 'Date', 'Reference' and 'Balance' value in the account’s 
operating currency.

● For a foreign currency bank account, accept or amend the 'Exchange rate' of the bank 
balance or the unreconciled transactions displayed. The rate is used to convert the bank 
values to base currency.

Outcomes

● The current balance on the bank account is updated to reflect the opening balance entries 
made.

Rectify an opening balance

Opening balances cannot be amended. If you make a mistake when entering an opening balance 
you can alter it by entering a payment or receipt, where appropriate, to adjust the opening 
balance. You need to make a note to reconcile this entry against the erroneous opening balance.

cash book manual.book  Page 35  Tuesday, February 19, 2008  11:02 AM



Sage 200 Cash Book 

36

Amend a Bank Account

It is important to maintain accurate bank account records on the Cash Book as details can 
change over time. All details can be changed except those maintained by the system; 'Last 
statement date', 'Current balance' and 'Base currency balance' on the 'Account Details' tab; and 
'Statement Balances' on the 'Statement Balances' tab.

You cannot change the account currency once you have started to post transactions to the 
account (including an opening balance transaction).

Finally, you cannot undo changes made. If you do find you have made a mistake simply re-enter 
the details.

Before you begin ...

You must have:

✔ Details of your Chart of Accounts. For more information see your Sage 200 Nominal Ledger 
User Guide.
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Access the window

Choose Cash Book Accounts > Amend Account Details.
          

Enter the details

● Select the account you want to amend using the 'Account ref' drop-down list.

● Update the required details. See Create a Bank Account Record on page 21.

● Use the 'Statement Balances' tab to view reconciled statement balances for the account. 
These are displayed if you have run 'Bank Reconciliation' for the account. For more 
information see Reconcile Bank Account on page 91.
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Delete a Bank Account

When a bank account becomes redundant it is possible to remove it from the Cash Book. 
However, this is only possible if the account conforms to certain criteria, thereby safeguarding 
against deleting an active account. This means the account must have a zero balance, there must 
be no transactions stored or pending for the account and there must be no standing orders or 
direct debits recorded for the account.

Before you begin ...

You must have:

✔ Reconciled all bank transactions. For more information see Reconcile Bank Account on page 
91.

✔ Deleted all reconciled bank account transactions.

✔ A zero bank balance by entering a transaction to counteract any outstanding bank balance. 
For more information see Record Nominal Payments or Receipts on page 56.

✔ Removed any recorded direct debits or standing orders associated with the account. See 
Manage Standing Orders and Direct Debits on page 40.
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Access the window

Choose Cash Book Accounts > Amend Account Details.
          

Enter the details

● Select the account you want to delete using the 'Account ref' drop-down list and then click 
'Delete'.

Outcomes

● The account is removed from the Cash Book.
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Manage Standing Orders and Direct Debits

The standing order and direct debit routine is an efficient way to deal with recurring bank 
transactions.

To set up a direct debit or standing order, both your Cash Book bank account and the trader or 
nominal account must operate in your base currency. Once this is established you can set up 
direct debits or standing orders on a monthly or quarterly basis or you can specify your own 
frequency. These postings reflect the direct debit and standing order commitments arranged 
with the financial organisation you deal with.

Direct debits or standing orders recorded on the Cash Book are processed to the appropriate 
accounts. You can invoke the postings whenever you want. This ensures your bank accounts are 
always up to date. 

The Standing Order and Direct Debit routine automatically compensates for weekends. If a 
standing order or direct debit is set to be paid on a weekend or on the 31st of the month when 
there is no 31st day in the month, the next banking day is calculated. This gives a more accurate 
picture when you come to reconcile your bank statements. However the routine does not take 
into account bank holidays.

You can set up standing orders and direct debits for regular sales receipts and supplier 
payments. You can also use them to manage payments and receipts which affect your nominal 
accounts, these can be either taxable or non-taxable.
          

Standing orders and direct debits which affect either a supplier or customer account are 
non-taxable entries. However, a direct debit or standing order applied to nominal accounts can 
be either a taxable or non-taxable entry. 
          

The Direct Debit and Standing Order report details the recurring bank transactions associated 
with an account. For more information see Standing order/direct debit level on page 108.

Note: You cannot set up direct debits or standing orders for foreign currency trader 
accounts.

Note: You cannot set up a direct debit or standing order if the supplier or customer account 
is on hold. If however you already have set up a standing order or direct debit on a 
trader account and then put the trader account on hold, the recurring postings continue 
to be made to the account while it is on hold.
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Set up a standing order or direct debit

You can use a direct debit to spread a total payment value over a set number of periods. 
Standing orders are used to record regular payments where the overall duration of the term is 
unknown.

Before you begin ...

You must have:

✔ Created your bank account.

✔ Created the trader account.

Access the window

Choose Standing Orders and Direct Debits > Maintain Standing Orders and Direct Debits.
          

Enter the details

● Select the bank account you want to record a standing order or direct debit to.
          

● Click 'Add' and the 'New Standing Order/Direct Debit' window appears.

Note: You can only use a foreign bank account if you intend to process nominal standing 
orders and direct debits.
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The following example illustrates the window displayed for a nominal non taxable payment 
direct debit.

          

● Select the 'Posting type' (sales receipt, purchase payment or nominal, taxable or non taxable, 
standing order or direct debit).

● Select the trader or nominal account to assign the entry to.

● Specify the entry details.

● Enter a narrative 'Description'.

● Assign references.

● Enter the 'Transaction analysis' code.
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● Enter the 'First payment date'.

● Enter the 'No. of Payments' (the number of times you want the direct debit to recur 
between 3 and 999 times).

● Enter the required 'Frequency' of payment ('Monthly', 'Quarterly' or 'Other'). For a 
frequency of 'Monthly' or 'Quarterly', enter the day of the month you want the entry 
made. If the frequency is 'Other', specify the number of 'Days between payments'.

● Select the 'Tax code' to be used, if you have elected to record a taxable nominal receipt or 
payment.

The Cash Book automatically calculates the tax period for you when you elect to record 
a taxable nominal payment or receipt. This tax period is used to add the entry to your 
'VAT Return'.

● For a direct debit specify the values.

● Enter the 'Total amount to pay' including the tax element, if applicable.

● The first direct debit value is automatically calculated for you (include the tax element, if 
you have elected to record a taxable nominal payment or receipt).

          

● Enter the last direct debit value (include the tax element, if you have elected to record a 
taxable nominal payment or receipt).

● For a standing order enter the regular values (include the tax element, if you have elected to 
record a taxable nominal payment or receipt).

The Cash Book calculates and displays the goods and tax values based on the regular value 
you have entered. You can amend the 'Goods' value or 'Tax' value and the Cash Book 
recalculates the values for you.

Note: 'Transaction analysis' codes are available if you have allowed additional 
transactional analysis in the Accounting System Manager settings. For more 
information see your Sage 200 Accounting System Manager documentation.

Note: If you are recording a taxable nominal payment or receipt, you can edit the 
calculated values.
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Outcomes

● The standing order/direct debit details are stored in the Cash Book.

Amend a standing order or direct debit

You can amend the details of a standing order or direct debit at any time. However, there are 
limitations. You cannot amend the:

● Initial 'Reference', date and the value of the first payment, regardless of whether postings 
have been made or not.

● 'Tax code' if postings have been generated.

If you decide to change the direct debit or standing order values, the Cash Book automatically 
recalculates and displays the remaining values for you.

You can also use this routine to view entries which have already been posted for a specific 
direct debit or standing order.

Access the window

Choose Standing Orders and Direct Debits > Maintain Standing Orders and Direct Debits.
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Enter the details

● Select the 'Cash bank account' the standing order or direct debit is assigned to.

● Select the one that you want to amend from the list of 'Standing orders/direct debits'.

● Click 'Edit' and the routine displays the current settings for the standing order or direct debit.

The following example illustrates the window used for a standing order. The window used 
for a direct debit differs slightly.

          

● Update the required details and click 'Save'. 

● To view entries which have already been posted for a specific direct debit or standing order, 
select the 'Posted Payments' tab.
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Delete a standing order or direct debit

Deleting a standing order or direct debit is a simple process and uses the window used to create 
or amend the recurring entries described above.

Access the window

Choose Standing Orders and Direct Debits > Maintain Standing Orders and Direct Debits.
          

Enter the details

● Select the 'Cash bank account' you want to delete a direct debit or standing order from.

● Select the redundant direct debit or standing order.

● Click 'Delete'.

● Click 'Yes' to confirm that you want to delete the direct debit or standing order.

Outcomes

● The standing order/direct debit is removed from the Cash Book.
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4
Manage Transactions

This chapter deals with handling receipts and payments 
associated with the organisations you trade with. It 
describes how to handle a single transaction or multiple 
transactions as well as recording the transfer of funds 
from one bank account to another.
          

Note: The chapter assumes transactions are entered in 
your base currency. The implications of 
working with foreign currency transactions are 
dealt with in a separate chapter. See Chapter 5, 
Manage Foreign Currency Transactions.

Activities:

Record a customer 
receipt

Record a customer 
payment

Record a supplier 
payment

Record a supplier 
receipt

Record nominal 
receipts or payments

Record multiple items

Record a bank transfer
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Before you begin ...

You must have:

✔ Created bank account records. For more information see 
Chapter 3, Establish and Maintain Bank Account Records.

          

Remember ...

For more information on using the help system, see the Sage 200 
Operations documentation.

Note: You must have suitable security privileges to perform 
these activities. See your system administrator for more 
information.

cash book manual.book  Page 48  Tuesday, February 19, 2008  11:02 AM



Chapter 4 Manage Transactions

49

Record Transactions

You can use the Cash Book to record receipts and payments for nominal, sales and purchase 
accounts. When entering sales and purchase transactions, you can also allocate the entry at the 
same time.

There are two methods you can use to enter transactions into the Cash Book.

● You can enter transactions as a single item.

The routines used to record sales and purchase transactions are the same routines used in the 
Sales and Purchase Ledgers and allow the allocation of transactions at the same time.

● You can group transactions.

Using the 'Grouped Transactions' routine, you can store a record of several transactions of 
the same type, save them and post them all at once. You can also edit or delete the 
transactions prior to posting. You can allocate customer and supplier transactions when 
using grouped transaction, but once allocated, you cannot edit or delete transactions prior to 
posting.
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Record Customer Transactions

Not only can you record customer receipts and payments in the Sales Ledger, you can also 
record them directly into the Cash Book as the same routines are used in both modules. You can 
also allocate customer receipts and payments within these routines. However you cannot 
allocate transactions on a balance forward type account.

If you decide to use the Cash Book to record the items it generates postings for both the Sales 
Ledger and Nominal Ledger.

Record a customer receipt

Customer receipts relate to outstanding invoice items or can be a one off payment on account.

Access the window

Choose Payments and Receipts > Sales and Purchase > Sales Receipt.
          

Enter the details

● Select the 'Bank account' to be used.

● Select the customer 'A/C ref'.

● Enter the 'Transaction details'.
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● Enter the 'Receipt details' ('Cheque currency', 'Cheque value' and the 'Settlement discount 
taken).

● Click 'Save' to save the receipt without allocating.

● Click 'Save and Allocate' to save the receipt and allocate to the outstanding transactions.

● Enter the allocation details, if appropriate. For more information about allocation see your 
Sage 200 Sales Ledger or Sage 200 Purchase Ledger documentation.

Outcomes

● The customer’s account balance is updated (decreased) by the value of the receipt or receipts 
posted (including discount if appropriate).

● The bank account (for the balance sheet) within the Nominal Ledger and within the Cash 
Book, is debited with the value of the receipt.

● The discount given account (for the profit and loss) within the Nominal Ledger is debited 
with the value of the settlement discount, if included.

● The sales control account (for the balance sheet) within the Nominal Ledger is credited with 
the value of the receipt plus any discount.

● Transactions are allocated if allocation has been selected.

Record a customer payment

This type of payment occurs when you need to issue a refund to a customer who has overpaid or 
reverse a receipt that has been returned void by the bank.
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Access the window

Choose Payments and Receipts > Sales and Purchase > Sales Payment
          

Enter the details

Recording a customer payment follows the same process used to record a customer receipt. See 
Record a customer receipt on page 50.

Outcomes

● The customer’s account balance is updated (increased) by the value of the payment of 
payments posted (including discount if appropriate).

● The bank account (for the balance sheet) within the Nominal Ledger and within the Cash 
Book, is credited with the value of the payment.

● The discount given account (for profit and loss) within the Nominal Ledger is credited with 
the value of the settlement discount, if included.

● The sales control account (for the balance sheet) within the Nominal Ledger is debited with 
the value of the payment plus any discount.

● Transactions are allocated if allocation has been selected.
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Record Supplier Transactions

Not only can you record supplier receipts and payments in the Purchase Ledger, you can also 
record them directly into the Cash Book as the same routines are used in both modules. You can 
also allocate supplier receipts and payments within these routines. However you cannot allocate 
transactions on a balance forward type account.

If you decide to use the Cash Book to record the items it generates postings for both the 
Purchase and Nominal Ledger.

Record a supplier payment

Use this routine to record a payment you have made to a supplier. This can be a payment for 
particular items or a payment on account. Payments are applied to supplier accounts in 
accordance with the account type. For more information see your Sage 200 Purchase Ledger 
User Guide.

Access the window

Choose Payments and Receipts > Sales and Purchase > Purchase Payment.
          

Enter the details

Recording a supplier payment follows the same process used to record a customer receipt. See 
Record a customer receipt on page 50.
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Outcomes

● The supplier’s account balance is updated (decreased) by the value (including any discount 
taken) of the payment or payments posted.

● The bank account (for the balance sheet within the Nominal Ledger and within the Cash 
Book) is credited with the value of the payment.

● The settlement discount taken account (for profit and loss) within the Nominal Ledger is 
credited with the value of the settlement discount, if included.

● The purchase control account (for the balance sheet) within the Nominal Ledger is debited 
with the value of the payment plus any settlement discount.

● Transactions are allocated if allocation has been selected.

Record a supplier receipt

Use this routine to reverse a cheque payment that has been returned as void by the bank or 
record a receipt from a supplier if you have over paid in the past.

Access the window

Choose Payments and Receipts > Sales and Purchase > Purchase Receipt.
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Enter the details

● Recording a supplier receipt follows the same process used to record a customer receipt. See 
Record a customer receipt on page 50.

Outcomes

● The supplier’s account balance is updated (increased) by the value of the receipt (including 
discounts if appropriate).

● The bank account (for the balance sheet) within the Nominal Ledger and within the Cash 
Book, is credited with the value of the receipt.

● The discount given account (for profit and loss) within the Nominal Ledger is credited with 
the value of the settlement discount, if included.

● The purchase control account (for balance sheet) within the Nominal Ledger is debited with 
the value of the receipt plus any discount.
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Record Nominal Payments or Receipts

Use this method to record money you receive or have paid that does not relate directly to a 
customer or supplier transaction.
          

These routines provides the extra facility for you to print a cheque when dealing with payments 
provided the cheque is in your base currency.

Any transaction entered using this routine can be analysed over several nominal accounts with 
one posting made to the bank account.

Access the window

Choose Payments and Receipts > Nominal > Nominal Taxable Receipt, or
Choose Payments and Receipts > Nominal > Nominal Taxable Payment, or
Choose Payments and Receipts > Nominal > Nominal Non-Taxable Receipt, or
Choose Payments and Receipts > Nominal > Nominal Non-Taxable Payment.

The following example uses a nominal taxable payment to illustrate the routine.
          

Note: All receipts and payments made in respect of customers and suppliers should be 
processed through the Sales Ledger, Purchase Ledger or Cash Book, where 
appropriate.
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Enter the details

● Select the 'Bank account' to be used.

● Enter the 'Transaction details' ('Cheque number', 'Transaction date', '2nd ref' and 'Narrative').

● Enter 'Nominal transactions' details.

● Enter the nominal 'A/C No.' to be used for each item.

● Enter a 'Reference' for each item.

● Enter the 'Narrative' description for each item.

● Enter the 'Trans. Date' for each item.

● Enter the 'Gross value' for each item.

● Enter the 'Tax Code' and 'Rate', if dealing with a taxable entry.

The routine calculates the 'Goods Value' and 'Tax Value' for you. These values can be 
amended. To do this, double-click the boxes and re-enter the values.

● Refine the 'Nominal transactions' entries if required by adding or deleting items from the list.

● To enter the payment, click 'Save'.

● Confirm intent to print a cheque.

Outcomes (VAT transactions)

● For receipts, the bank or petty cash account is debited with the value of the receipts and 
corresponding credit entries are made in the appropriate income accounts. The VAT control 
account is credited with the amount of VAT. The VAT table is updated with the goods and 
VAT involved for each line in the journal.

● For payments, the bank or petty cash account is credited with the value of the payments and 
corresponding debit entries are made in the appropriate expense accounts. The VAT control 
account is debited with the amount of VAT. The VAT Return is updated with the goods and 
VAT involved for each line in the journal.
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Outcomes (non VAT transactions)

● For receipts, the bank or petty cash account is debited with the value of the receipts and 
corresponding credit entries are made in the appropriate income accounts.

● For payments, the bank or petty cash account is credited with the value of the payments and 
corresponding debit entries are made in the appropriate expense accounts.

          

Note: Only one entry is posted to the bank account, which represents the total of the nominal 
analysis lines.
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Record Multiple Items

The 'Grouped Transactions' routine is ideal when you need to process many transactions of the 
same type at the same time. This means you can enter several transactions together in a list and 
then post them to the ledger in one go, instead of posting transactions individually.

You can group receipts and payments and post them at the same time, although the group can 
only contain one type of transaction at any one time.
          

This routine is similar in principle to 'Batched Transactions' routines provided in other Sage 200 
modules, however there are a number of differences:

● Regardless of how many items are entered, only one posting to the Cash Book is made. This 
means the routine totals the grouped entries and applies the total value to the appropriate 
bank account. However the routine posts the required individual entries to the Sales, 
Purchase or Nominal Ledger, where appropriate.

● There is no total number or total value control which is found in the 'Batched Transactions' 
routine.

● You cannot hold the group entries as you can with batch processing.

● You can allocate entries using the routine. However, once you have allocated entries you 
cannot delete the group, or edit or delete those entries which are allocated in the group.

● You can process receipts or payments for customers or suppliers in a foreign currency 
provided certain criteria is met. For more information see Record Multiple Items on page 80.

Note: You cannot process nominal payments or receipts using this routine.
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Access the window

Choose Payments and Receipts > Sales and Purchase > Grouped Transactions.
          

Enter the details

● Select the 'Bank account' to be used.

● Select the 'Posting type' ('Sales Payment', 'Sales Receipt', 'Purchase Payment', 'Purchase 
Receipt').

● Enter the 'Transaction details' ('Date', 'Reference', 'Description' and, if required, the 
'Exchange rate' to be used for the group of transactions).

● Click 'Add'. The routine displays the appropriate transaction type window for you to 
complete. For example, if you choose transaction entry type purchase payment the routine 
displays the 'Enter Supplier Payment' window.

● To amend a transaction prior to posting, select the transaction, click 'Edit' and make the 
required changes.
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● To delete a transaction prior to posting, select the transaction and click 'Delete'.

● Add each transaction to the group list following the same rules used to enter the 'Posting 
type' you are dealing with. See your Sage 200 Purchase Ledger and Sage 200 Sales Ledger 
documentation.

● Allocate trader entries if required. For more information regarding allocation see your Sage 
200 Sales Ledger or Sage 200 Purchase Ledger documentation.

● Click 'Save' to commit the transactions to the ledgers.

Outcomes

● For receipts, the bank account is debited with the total value of the receipts while separate 
corresponding debit entries are made in the appropriate sales or purchase accounts.

● For payments, the bank account is credited with the total value of the payments. Separate 
corresponding debit entries are made in the appropriate sales or purchase accounts.

● Postings are made to the Nominal Ledger accounts for bank, sales and debtors control. For 
receipts, the control accounts are credited while the nominal bank account is debited. For 
payments, the control accounts are debited and the nominal bank account credited.

● One unique reference number is allocated to the grouped entries.
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Record a Bank Transfer

Use this routine to record the movement of money from one bank account to another. Not only 
can you record the transfer of money between bank accounts which use the same currency, you 
can also record the movement of money between bank accounts that operate in different 
currencies.

Access the window

Choose Other Transactions > Inter Account Transfer.
          

Enter the details

● Select the 'Payment account' bank account.

● Select the 'Receipt account' bank account.

● Enter the 'Transfer details' ('Description', 'Reference', 'Second reference' and 'Transfer date').

● Enter the 'Payment value'.

● Click 'Save'.

Outcomes

The receiving bank account is debited and the paying bank account is credited.
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5
Manage Foreign Currency 
Transactions

This chapter builds on Chapter 4 which describes the 
management of transactions in your base currency. The 
aim of this chapter is to explain the additional 
considerations and routines required when dealing with 
foreign currency transactions.

This chapter also explains the facilities you can use to 
manage your trade in foreign currencies.

This chapter does not cover EC implications or 
triangulation. For more information see your Sage 200 
Accounting System Manager documentation.

Activities:

Record supplier 
payments and receipts

Record customer 
receipts and payments

Record nominal 
payments and receipts

Record a bank transfer

Record multiple items

Manage exchange rate 
changes
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Before you begin ...

You must have:

✔ Set the currency descriptions and exchange rates for foreign 
currency accounts. For more information see Sage 200 
Accounting System Manager documentation.

✔ Created your foreign currency bank account. For more 
information see Create a Bank Account Record on page 21.

          

Remember ...

For more information on using the help system, see the Sage 200 
Operations documentation.

Note: You must have suitable security privileges to perform 
these activities. See your system administrator for more 
information.
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Overview

The Cash Book operates in both base and foreign currencies. Sage 200 can hold up to 100 
currencies. One currency is your base currency and the remaining 99 can be used for the foreign 
currencies in which your suppliers and customers operate.

Foreign currency transactions are handled in much the same way as you would handle your base 
currency transactions, but there are two main differences.

● First, the Cash Book uses the exchange rate table to calculate the value of your foreign 
currency transaction in your base currency. For more information regarding the exchange 
rate table see the Sage 200 Accounting System Manager documentation.

● Second, the transactions are subject to constant exchange rate fluctuations which affect the 
transaction value stored on the Cash Book.

Postings which result from foreign transactions are made to the Nominal Ledger in your base 
currency.

To manage the effect exchange rate changes have on these transactions, the Cash Book applies 
foreign bank revaluation once you have invoked the 'Foreign Bank Revaluation' routine. This 
process tidies up the loss or gain on the bank account that results as exchange rates fluctuate 
between the time of entering the bank transaction onto the account and any change in the system 
exchange rate. See Manage Exchange Rate Changes on page 83. If the transaction relates to a 
foreign customer or supplier then the gains and losses are dealt with by the 'Foreign Account 
Revaluation' routine in both the Sales Ledger and Purchase Ledger. For more information see 
your Sage 200 Purchase Ledger and Sage 200 Sales Ledger documentation.

If you do not have the 'Foreign Account Revaluation' setting activated in the Sales Ledger and 
Purchase Ledger, you can enter the loss/gain on exchange at the time of entering the transaction.

You can process several foreign currency transactions using the 'Grouped Transactions' routine, 
provided all the transactions are of the same type, use the same currency and you have created a 
bank account with the same currency used for the transactions.
          

Note: You cannot use the 'Reverse Transaction' routine located in the Sales Ledger and 
Purchase Ledger when dealing with foreign currency transactions. If an error has been 
made you have to post an opposite entry, for example a receipt reverses a payment. 
However you must take into consideration the exchange rate and any revaluation 
performed on the transaction.
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Record Supplier Payments and Receipts

The same payment routine and receipt routines used to record base currency cash transactions 
associated with your suppliers are used to record those for foreign currency. The differences 
when dealing with a foreign currency transaction are:

● Applying an exchange rate.

Any exchange rate variations are handled within the Foreign Bank Revaluation routine, 
which is described later in this chapter.

● Entering an exchange loss or gain on the transaction, only if you are not using 'Foreign 
Account Revaluation'.

The loss or gain on the transaction is entered in the 'Bank charges' area of the window, 
selecting the Currency Adjustments nominal account.

● Entering bank charges, if applicable.

The routines provide flexibility when dealing with currencies, which means the currencies 
specified for the transaction, supplier account and bank account can all differ. This is 
particularly useful if you need to record a transaction to a foreign supplier account when you do 
not operate a bank account in the supplier's currency.

You can access both the supplier payment and receipt routines in the Purchase Ledger as well as 
the Cash Book.

Provided you use a bank account in the same currency as the payment you intend to make, for 
example, trading with a supplier in the USA and you also have a US Dollar bank account, you 
can use the Purchase Ledger payment processing routine. For more information see your Sage 
200 Purchase Ledger User Guide.

This activity covers both payment and receipts received from your suppliers, although the 
example shown is for payments.
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Access the window

Choose Payments and Receipts > Sales and Purchase > Purchase Payment.
          

Enter the details

● Select the bank account you intend to use.

● Select the supplier account you want to apply a payment record to.

● Enter the 'Transaction details'.

● Enter 'Payment details' normally in the supplier's currency ('Cheque currency', 'Cheque 
value' and 'Settlement discount').

● Enter the 'Exchange rate' details.

● Accept or amend the 'Exchange rate' value. 
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When you select the 'Exchange Rate' button to amend the exchange rate value, the ledger 
displays the following window.

          

          

● Enter the 'Bank charges' and other charges, if applicable (bank charges are in the same 
currency as the bank account). You also need to accept or amend the nominal analysis code 
displayed and apply a 'Narrative' if required.

● Click 'Save' to save the payment without allocating.

● Click 'Save and Allocate' to save and allocate the payment to the outstanding transactions.

● Enter the allocation details, if appropriate. For more information see your Sage 200 
Purchase Ledger User Guide.

Note: If you do not amend the exchange rate then the displayed exchange rate is used for 
the transaction.
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Outcomes

The routine produces the following outcomes for both payment and receipt entry.
          

Payment Receipt

● The supplier’s account balance is updated 
(decreased) by the value (including any 
discount taken) of the payment or 
payments posted.

● The supplier’s account balance is updated 
(increased) by the value of the receipt 
(including discounts if appropriate).

● The bank account (for the balance sheet 
within the Nominal Ledger and within the 
Cash Book) is credited with the value of 
the payment.

● The bank account (for the balance sheet 
within the Nominal Ledger and within the 
Cash Book) is debited with the value of the 
receipt.

● The bank account (for profit and loss) is 
updated with the value of any charges, if 
applicable.

● The bank account (for profit and loss) is 
updated with the value of any charges, if 
applicable.

● The settlement discount taken account (for 
profit and loss) within the Nominal Ledger 
is credited with the value of the settlement 
discount, if included.

● The discount given account (for profit and 
loss) within the Nominal Ledger is debited 
with the value of the settlement discount, 
if included.

● The creditors control account (for the 
balance sheet) within the Nominal Ledger 
is debited with the value of the payment 
plus any settlement discount.

● The creditors control account (for balance 
sheet) within the Nominal Ledger is 
credited with the value of the receipt plus 
any discount.

● Any currency adjustments are posted, if 
applicable.

● Any currency adjustments are posted, if 
applicable.
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Record Customer Receipts and Payments

The same receipt and payment routines used to record base currency cash transactions 
associated with your customers are used to record those for foreign currency. The differences 
when dealing with a foreign currency transaction are: 

● Applying an exchange rate.

Any exchange rate variations are handled within the 'Foreign Bank Revaluation' routine, 
which is described later in this chapter.

● Entering an exchange loss or gain on the transaction, only if you are not using 'Foreign 
Account Revaluation'.

The loss or gain on the transaction is entered in the 'Bank charges' area of the window, 
selecting the Currency Adjustments nominal account.

● Entering bank charges, if applicable.

You can access both the customer receipt and payment routine in the Cash Book as well as the 
Sales Ledger.

By using the integrated Cash Book bank accounts to record bank transactions you have greater 
flexibility when recording foreign currency transactions. You can have any mix of currencies 
when recording the transaction, if it is required; this means the currencies specified for the 
transaction, customer account and bank account can all differ. If you are using a nominal bank 
account to record your bank transactions then you can only record transactions in the currency 
set on the customer’s account.

This activity covers both receipts issued to your customers and any payments made, although 
the example shown is for a receipt.
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Access the window

Choose Payments and Receipts > Sales and Purchases > Sales Receipt.
          

          

Enter the details

● Select the 'Bank account' to be used.

● Select the customer account you want to apply a receipt to.

● Enter the 'Transaction details'.

Note: The following information will describe the activity to record your receipt onto the 
Sales Ledger. The above window displays one of the forms used to record a receipt. 
The details displayed on the actual window you use depend on the nature of the 
receipt. For more information see your Sage 200 Sales Ledger User Guide.
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● Enter 'Receipt details' in the customer's currency, but this can be overridden (currency used, 
cheque value and settlement discount).

● Enter the 'Exchange details'.

When you select the 'Exchange Rate' button to amend the exchange rate value, the ledger 
displays the following window.

          

          

● Accept or amend bank charges, adding any other charges if appropriate (bank charges are in 
the same currency as the bank account). You also need to accept or amend the nominal 
analysis code displayed and apply a narrative if required.

          

● Click 'Save' to save the receipt without allocating.

● Click 'Save and Allocate' to save and allocate the receipt.

● Enter the allocation details if appropriate. For more information see your Sage 200 Sales 
Ledger User Guide.

          

Note: If you do not amend the exchange rate then the displayed exchange rate is used for 
the transaction.

Note: Values entered here are in the base currency.

Note: Depending on the method you choose to enter receipts, you may or may not need to 
allocate the receipt to the invoice. For more information see your Sage 200 Sales 
Ledger User Guide.
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Outcomes 

The activity produces the following outcomes for both receipt and payment entry.
          

Receipt Payment

● The customer’s account balance is 
updated (decreased) by the value of the 
receipt or receipts posted (including 
discount if appropriate).

● The customer’s account balance is updated 
(increased) by the value of the payment or 
payments posted (including discount if 
appropriate).

● The bank account (for the balance 
sheet) within the Nominal Ledger and 
within the Cash Book, is debited with 
the value of the receipt.

● The bank account (for the balance sheet) 
within the Nominal Ledger and within the 
Cash Book, is credited with the value of the 
payment.

● The bank account (for profit and loss) 
is updated with the value of any 
charges, if applicable.

● The bank account (for profit and loss) is 
updated with the value of any charges, if 
applicable.

● The settlement discount allowed 
account (for the profit and loss) within 
the Nominal Ledger is debited with the 
value of the settlement discount, if 
included.

● The settlement discount allowed account 
(for the profit and loss) within the Nominal 
Ledger is credited with the value of the 
settlement discount, if included.

● The debtors control account (for the 
balance sheet) within the Nominal 
Ledger is credited with the value of the 
receipt plus any discount.

● The debtors control account (for the balance 
sheet) within the Nominal Ledger is debited 
with the value of the payment plus any 
discount.

● Any currency adjustments are posted, if 
applicable.

● Any currency adjustments are posted, if 
applicable.
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Record Nominal Payments or Receipts

You can use this method to record foreign currency you receive or have paid that does not relate 
directly to a customer or supplier transaction.
          

This routine works in a similar manner as that used for your base currency nominal payments or 
receipts. The differences when dealing with foreign currency transactions are:

● You must select a foreign currency bank account to record the entry.

● The transaction currency and bank currency do not need to match. This means you can 
record a foreign currency transaction even if you do not operate a foreign bank account in 
that currency.

● You need to enter an exchange rate and bank charges, where applicable.

● You cannot print a foreign currency cheque using this routine.

Note: All receipts and payments made in respect of customers and suppliers should be 
processed through the Sales Ledger, Purchase Ledger or Cash Book, where 
appropriate.
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Access the window

Choose Payments and Receipts > Nominal > Nominal Taxable Receipt, or 
Choose Payments and Receipts > Nominal > Nominal Taxable Payment, or
Choose Payments and Receipts > Nominal > Nominal Non-Taxable Receipt, or
Choose Payments and Receipts > Nominal > Nominal Non-Taxable Payment.

The following example uses a nominal non-taxable receipt to illustrate the routine.
          

Enter the details

● Select the 'Bank account' to be used.

● Enter the 'Transaction details' ('Cheque number', 'Transaction date', '2nd ref' and 'Narrative').

● Enter the 'Transaction values' by:

● Entering the 'Cheque value'.
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● Accepting or amending the 'Cheque currency' for the entry.

● Accepting or amending the 'Exchange rate'.

● Enter the 'Bank charges', this includes other applicable charges (bank charges are in the same 
currency as the bank account).

● Enter the loss or gain on exchange, if applicable, in the 'Bank value' box.
          

● Enter 'Nominal transactions' details.

● Enter the nominal account to be used for each item.

● Enter a reference and a narrative description for each item.

● Enter the date for each item.

● Enter the gross (goods) value for each item.

● If required, refine the entry by adding or deleting the nominal analysis.

● To enter the receipt, click 'Save'.

Outcomes (VAT transactions)

● For receipts, the bank or petty cash account is debited with the value of the receipts and 
corresponding credit entries are made in the appropriate income accounts. The VAT control 
account is credited with the amount of VAT. The VAT table is updated with the goods and 
VAT involved for each line in the journal.

● For payments, the bank or petty cash account is credited with the value of the payments and 
corresponding debit entries are made in the appropriate expense accounts. The VAT control 
account is debited with the amount of VAT. The VAT Return is updated with the goods and 
VAT involved for each line in the journal.

● Any currency adjustments are posted, if applicable.

● The bank account (for profit and loss) is updated with the value of any charges, if applicable.

Note: If a loss has been made then enter the amount as a positive value, for example 125.00. 
If a gain has been made then enter the amount as a negative, for example -125.00.
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Outcomes (non VAT transactions)

● For receipts, the bank or petty cash account is debited with the value of the receipts and 
corresponding credit entries are made in the appropriate income accounts.

● For payments, the bank or petty cash account is credited with the value of the payments and 
corresponding debit entries are made in the appropriate expense accounts.

● Any currency adjustments are posted, if applicable.

● The bank account (for profit and loss) is updated with the value of any charges, if applicable.
          

Note: Only one entry is posted to the bank account which represents the total of the nominal 
analysis lines.
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Record Bank Transfer

Use this routine to record the movement of money from one bank account to another.

When you enter foreign currency transactions using this routine you will need to specify the 
following:

● Exchange rate for the bank accounts involved.

● Exchange rates to your base currency for your nominal postings.

Access the window

Choose Other Transactions > Inter Account Transfer.
          

Enter the details

● Select the 'Payment account' bank account from the 'Payment account' drop-down list.
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● Select the 'Receipt account' bank account from the 'Receipt account' drop-down list.

● Enter the 'Transfer details' ('Description', 'Reference', 'Second Reference' and 'Transfer 
date').

● Enter the 'Payment value' of the transfer in either the currency of the paying bank or 
receiving bank.

The routine automatically calculates the remaining value for you based on the exchange 
rate.

● Accept or amend the 'Exchange rate', if required. 

● Enter the 'Commission' details, if applicable.

● Enter the 'Commission value'.

● Assign the commission to a bank by selecting 'Payment account' or 'Receipt account'.

● Accept or amend the nominal 'Commission account' for commission charges.

● Enter the 'Nominal postings' details.

● Accept or amend the exchange rates.

One exchange rate is required if you are transferring money between a foreign currency 
bank account and a base currency bank account. Two exchange rates are required if you 
are transferring money between two foreign currency bank accounts.

The 'Exchange difference' is automatically calculated for you when you amend the 
displayed exchange rates.

● Select the required 'Nominal account' for exchange differences.

Outcomes

● The receiving bank account is debited and the paying bank account is credited.

● Commission nominal account postings are made, if applicable.

● Currency adjustment postings are made, if appropriate.
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Record Multiple Items

This routine is ideal when you need to process many transactions of the same type at the same 
time. This means you can enter several transactions together in a list and then post them to the 
ledger in one go, instead of posting transactions individually.

You can group receipts and payments and post them at the same time, although the group can 
only contain one type of transaction at any one time.

You can successfully process receipts or payments for customers or suppliers in a foreign 
currency provided:

● You operate a foreign bank account in the same currency as the entries you intend to record.

● All entries in the group use the same currency.
          

This routine is similar in principle to batch processing provided in other Sage 200 modules, 
however there are a number of differences:

● Regardless of how many items are entered, only one posting to the Cash Book is made. This 
means the routine totals the entries and applies the total value to the appropriate bank 
account. However the routine posts the required individual entries to the Sales, Purchase or 
Nominal Ledger, where appropriate.

● There is no total number or total value control that is found in the batch processing routine.

● You cannot hold the group entries as you can with batch processing.

● You can allocate entries using the routine. However, once you have allocated entries you 
cannot delete the group, or edit or delete those entries that are allocated in the group.

Note: You cannot process nominal payments or receipts using this routine.
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Access the window

Choose Payments and Receipts > Sales and Purchase > Grouped Transactions.
          

Enter the details

● Select the 'Bank account' to be used from the 'Bank account' drop-down list.

● Select the transaction type from the 'Posting type' drop-down list ('Sales Payment', 'Sales 
Receipt', 'Purchase Payment' or 'Purchase Receipt').

● Enter the 'Transaction details' ('Date', 'Reference', 'Description').

● Accept or amend the 'Exchange rate'.

● Click 'Add'. The routine displays the appropriate transaction type entry window for you for 
example, if you choose the purchase payment transaction entry type, the routine displays the 
'Enter Supplier Payment' window.

● Add each transaction to the group list following the same rules used to enter the transaction 
type you are dealing with. See your Purchase Ledger User Guide, Sales Ledger User Guide 
and Nominal Ledger User Guide.
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● To amend a transaction prior to posting, select the transaction and click 'Edit' and make the 
required changes.

● To delete a transaction prior to posting, select the transaction and click 'Delete'.

● Allocate trader entries if required. For more information regarding allocation see your Sage 
200 Sales Ledger or Sage 200 Purchase Ledger documentation.

● Click 'Save' to commit the transactions.

Outcomes

● For receipts, the bank account is debited with the total value of the receipts while separate 
corresponding debit entries are made in the appropriate sales or purchase accounts.

● For payments, the bank account is credited with the total value of the payments. Separate 
corresponding debit entries are made in the appropriate sales or purchase accounts.

● Postings are made to the Nominal Ledger accounts for bank, sales and debtors control. For 
receipts, the control accounts are credited while the nominal bank account is debited. For 
payments, the control accounts are debited and the nominal bank account credited.

● One unique reference number is allocated to the grouped entries.
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Manage Exchange Rate Changes

As exchange rates fluctuate you need to know how the change has affected the bank account 
balance and then bring the balance up to date. To do this you need to use the revaluation routine 
on the Cash Book.
          

The revaluation routine displays the current balance on the account in the account’s operating 
currency as well as the equivalent value in your base currency. The account balance is revalued 
using the system exchange rate. The system exchange rate, stored in the exchange rate table in 
the Accounting System Manager, is displayed when you invoke the 'Foreign Bank Revaluation' 
routine. The exchange rate can be overridden if required. For more information about the 
exchange rate table see your Sage 200 Accounting System Manager documentation.

Exchange rate differences are posted to the Currency Adjustments account in the Nominal 
Ledger. If you have set the Nominal Ledger to update on-line the postings are immediately 
applied to the Nominal Ledger. However, if you do not use on-line update the postings are held 
in a pending entry file until such time when you run the update postings routine on the Nominal 
Ledger. For more information see your Sage 200 Nominal Ledger User Guide.
          

The routine produces a report detailing the nominal postings made as a result of the revaluation 
process.

Note: You cannot revalue a bank account if either the account balance or the core currency 
balance is zero.

To establish the exchange difference the system performs the following calculation:

foreign currency balance
1. --------------------------- = new base currency value

new exchange rate

2. (old base currency value) - (new base currency value)

 = exchange difference (gain or loss)

For each bank account the system stores the current balance in the operating currency and its 
equivalent in the base currency. As the latter is stored to two decimal places, the actual 
exchange rate may not be exactly what you entered last time you revalued. You may have 
some small numbers after the decimal point. This is quite normal and should not be cause for 
concern.
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Access the window

Choose Period End Routines > Foreign Bank Revaluation.
          

Enter the details

● Select the 'Bank account' you want to revalue.

● Enter the 'Revaluation date'.

● Amend the 'New rate' of exchange.

● Enter the 'Transaction details'.

The 'Exchange difference' value is automatically calculated and displayed.
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Outcomes

● The revaluation reports are produced.

● The account balance is adjusted accordingly. This is reflected in the operating currency for 
the account and its equivalent value in your base currency.

● Currency adjustment postings are made to the Nominal Ledger.
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6
Manage Bank Accounts

This chapter deals with the bank account as a whole, 
covering both the bank account record and its associated 
transactions.

Primarily the chapter deals with the activities you need to 
perform to keep your bank account balances up to date, 
thereby providing you with accurate and complete cash 
records.

This chapter also explains the various reports used to 
manage your bank accounts.

Activities:

Apply postings

Process standing 
orders and direct 
debits

Reconcile printed 
bank statement

Reconcile electronic 
bank statement

Query accounts

Prepare account 
reports

Delete reconciled 
transactions
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Before you begin ...

You must have:

✔ Applied transactions to your bank accounts. For more 
information see Chapter 4, Manage Transactions and Chapter 
5, Manage Foreign Currency Transactions.

          

Remember ...

For more information on using the help system, see the Sage 200 
Operations documentation.

Note: You must have suitable security privileges to perform 
these activities. See your system administrator for more 
information.
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Manage Pending Transactions

Use the 'Update Pending Transactions' routine to add transactions to the Cash Book that have 
been created externally, if applicable.

The routine validates the transactions in the posting file before committing them to the bank 
accounts. If it identifies transactions for a bank account which the ledger does not recognise, it 
removes the transactions from the process and continues processing the remaining transactions.

If you have set the Accounting System Manager to update the Nominal Ledger on-line then this 
activity also updates the Nominal Ledger accounts.

Before you begin ...

✔ Check to see if you have any transactions waiting to be processed to the Cash Book. This 
activity provides you with a report either printed or to be viewed on screen. Choose Period 
End Routines > Report Pending Transactions.

Access the window

Choose Period End Routines > Update Pending Transactions.
          

Enter the details

● Click 'OK'.
          

Outcomes

● The transactions are applied to the bank account and the balances adjusted accordingly.

● The value held for all transactions in the bank account are also adjusted accordingly.

Note: If there are no transactions pending entry, the routine terminates and a message is 
displayed.
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Process direct debits or standing orders

Use this routine to post the transactions for standing orders and direct debits.

The routine adjusts the payment date to compensate for weekends. It checks if the required 
payment falls on either a Saturday or Sunday. If this is found to be the case the routine generates 
the transaction for the Monday.

Access the window

Choose Standing Orders and Direct Debits > Process Standing Orders and Direct Debits.
          

Enter the details

● Enter the date you want the transactions processed to.

● Click 'OK'.

Outcomes

● The standing orders and/or direct debits are processed and a report is produced, showing the 
postings cleared by the process.
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Reconcile Bank Account

When you receive a bank statement your next step is usually to reconcile the statement with the 
transactions recorded on the bank account in the Cash Book. By completing this process you 
can identify any discrepancies that require further action.

How you perform this activity within Sage 200 depends on your system settings. If you have 
enabled e-Banking in the Purchase Ledger and set electronic reconciliation for the account, the 
activity is performed electronically. This involves importing a file from your banking software 
containing your current statement and then reconciling these transactions with those in your 
Cash Book. For more information see Enter a new bank account on page 29. 

If you have not enabled e-Banking, the activity is performed manually using your printed bank 
statement and reconciling the transactions on the statement to the payment and receipt 
transactions recorded in the Cash Book.

Reconcile printed bank statement

The first time you use this routine the system displays the current date in the 'Statement date' 
box. You need to override the system date and enter the correct statement date.

The routine includes a level of control to ensure that reconciled transactions applied against the 
opening balance, match the closing balance on the bank statement. This is achieved by entering 
a 'Projected closing balance' which is the actual closing balance on the bank statement.

Unpresented transactions are automatically displayed by the routine, although you can choose to 
display all transactions, which includes the presented transactions. The transactions can be 
sorted by date, reference, payment value or receipt value. You can even search for a particular 
transaction by date, reference or value.

Reconciliation takes place by selecting the unpresented transactions and choosing to reconcile 
those transactions. If you find the transaction value differs from that stated on the bank 
statement you can adjust the value accordingly. If you select a transaction with a date later than 
the bank statement date, the routine warns you but you can continue with the reconciliation. 
However, it is likely that this action will result in discrepancies between your projected balance 
and the balance on the Cash Book account.

If you find transactions on the bank statement which have been omitted from your Cash Book 
bank account you can enter the details during the process. Once you have entered the omitted 
transactions you can then refresh the displayed transactions in the sort order you require.
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As an alternative to reconciling transactions on an individual basis you can choose to reconcile 
all displayed transactions. The routine automatically sets the 'Statement Value' to match the 
value for each transaction dated on or before the 'Statement date'.

You can remove the reconciled status from transactions either on an individual basis or for all 
transactions provided you have not committed the reconciled transactions to the Cash Book.

On completing the process the routine automatically prints a report detailing the transactions 
which have been reconciled as well as those transactions which are classed as unpresented.
          

Once you have reconciled the transactions you can then delete them from the Cash Book. See 
Delete Reconciled Transactions on page 111.

Before you begin ...

You must have:

✔ Updated all pending postings to the Cash Book. See Manage Pending Transactions on page 
89.

Note: It is important to retain the report generated by the routine to enable you to identify 
the bank account’s original opening balance. When you start to delete reconciled 
transactions from the bank account, the value of the deleted transactions is added to 
the opening balance. Without the initial report you cannot identify the actual opening 
balance.
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Access the window

Choose Period End Routines > Bank Reconciliation. 
          

Enter the details

● Select the bank account to be reconciled.

● Enter the bank 'Statement date'.
          

● Enter the 'Page number' of the statement being reconciled.

● Check the displayed 'Statement opening balance' matches the opening balance on the bank 
statement.

Note: The statement date cannot be a date later than the current system date.

cash book manual.book  Page 93  Tuesday, February 19, 2008  11:02 AM



Sage 200 Cash Book 

94

          

● Enter the 'Projected closing balance' printed on the bank statement.

● If you want to view both reconciled and unreconciled transactions select the 'Show all 
transactions' option.

● Reconcile the displayed transactions by selecting the transactions using the 'Statement 
Value' check boxes, adjusting values if required, and then click 'Save'. Remember: you can 
move the column order on the transaction list by dragging and dropping the column 
headings to suit your work flow.

          

Alternatively, you can use the 'Auto Select' option to reconcile all unreconciled transactions 
up to the Statement Date.

● If you need to change the statement value for a specific transaction, to a set value, select the 
appropriate Statement Value cell and type in the value. When you move out of the 
'Statement Value' cell, the system selects the check box to show this value has been set.

● Add any omitted transactions to the bank account by selecting the appropriate transaction 
type from the 'Add transaction of type' drop-down list. The relevant transaction entry 
window appears.

Note: If you enter a book balance for a bank account you should reconcile the bank 
account before entering any bank transactions. This ensures the 'Statement 
opening balance' is updated.

Note: You can select multiple transactions for reconciliation, in several different ways:

● To select all the transactions for reconciliation click 'Select All'. All the 'Statement 
Value' check boxes appear selected. 

● To select a range of values for reconciliation, select the first date in the range, hold 
down SHIFT and select the last date in the range you want to reconcile. Now select 
the 'Statement Value' check box on the first transaction. This selects all transactions in 
the range you have specified. 

● To select multiple non-consecutive transactions, simply select the 'Statement Value' 
check boxes of the transactions you want to reconcile.

You can also apply these processes on selected transactions to de-select transactions 
before running the reconciliation procedure.
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● To confirm the process is complete, click 'Save'.

If the reconciled entries applied to the opening balance do not match, a warning is displayed. 
Continue to make further adjustments to the values until the figures match.

Outcomes

● The statement date and statement value on each reconciled item is updated.

● The statement date and statement balance on the bank account is updated.

● Reports are generated.

Reconcile electronic bank statement

Electronic reconciliation involves importing bank transactions from your banking service 
software into Sage 200. The transactions are then matched to those stored in the Cash Book 
bank record. By doing so, the status of the transactions in both areas is changed.

Reconciliation should only be carried out once within a given day and we recommend 
transactions are only reconciled up to the end of the previous day. This ensures all transactions 
for the dates you intend to reconcile are fixed and you capture a complete record of transactions 
when you import your bank file. If you find this is not the case you will need to get back to a 
suitable starting point so that transactions can be imported and reconciled again. See Delete 
imported transactions on page 103.

There are several ways you can match transactions, you can:

● Use the automatic matching options, ('Match Amounts'. 'Match Refs' or 'Match Full') to 
reconcile the majority of your transactions.

● Use the 'Match Manual' option to reconcile any outstanding transactions.

We recommend that you use both the automatic and manual matching options.

You can match transactions that differ in value although the routine displays a warning before 
the selection is confirmed. You cannot match payments to receipts. 

Note: You can refresh the window to display the added transactions in the correct 
sequence. To do this select the 'Show unreconciled transactions only' option.
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Transactions from the bank file which are not matched during the process are retained and 
displayed again when you next import transactions.

There are several values displayed by the 'Bank Reconciliation' routine. Those of particular 
interest are the 'Book Balance at Date' (bank account balance in the Cash Book) and the 
'Statement End Balance' (balance with your financial organisation). In an ideal situation these 
values would match; however this is unlikely as transactions await clearance at the bank.

Another displayed value is the 'Difference' value; this represents the difference between the 
transactions that have been selected for reconciliation and the 'Statement End Balance'. As 
transactions are reconciled the 'Difference' value reduces until a value of zero is displayed. 
However, if bank charges or interest payments are included in the bank file then the 'Difference' 
value will only reduce to the value of these charges indicating an adjustment to the bank record 
in the Cash Book is required.
          

After completing reconciliation you can change the status of transactions in the bank file from 
reconciled to unreconciled and back again to deal with errors or transactions that have been 
overlooked.

Note: You cannot make adjustments to the Cash Book bank record using this routine. To 
account for bank charges or interest payments shown on your electronic bank 
statement, use the Cash Book 'Payments and Receipts' routines. If you have made an 
error when entering the transaction in the Cash Book you can only reconcile the 
transactions by switching off e-banking on the bank account and using manual 
reconciliation to reconcile the transactions.
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There are a number of areas you can control to help you when reconciling transactions. You 
can:

● Control how the matching facility works.

● Set a discard date to reject transactions before a specified date when you are importing the 
bank file.

For more information see Appendix 9, e-Banking Options.

Import and reconcile statement

The electronic banking service software supplied by the bank saves your bank information into 
a file on your PC. To reconcile your bank transactions you must import your bank data into 
Sage 200.

The transactions are matched either manually or automatically. Depending on how the 
electronic reconciliation routine is set up the matched transactions are then confirmed before 
they are finally saved as reconciled. For more information see Set the matching facility on page 
152.

Confirming transactions saves those transactions you have matched. This is a transitional stage 
before the transactions are finally reconciled. You can view the status of transactions before 
they are finally reconciled. You can view transactions which are not confirmed, confirmed or 
both (all).

If you match and confirm the wrong transactions this can be reversed so that the correct 
selection can be made.

Before you begin ...

You must have:

✔ Set up the bank account for electronic banking. For more information see Enter a new bank 
account on page 29.

✔ Set up electronic bank reconciliation routine to meet your needs. For more information see 
e-Banking Options on page 151.

✔ Identified the statement date and balance in your electronic banking service software.
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Access the window

Choose Period End Routines > Bank Reconciliation.
          

Enter the details

● Select the bank account you want to reconcile. The following window appears.
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● Enter the 'Statement End Date' and 'Statement End balance' as specified in your electronic 
banking service software.

          

● Click 'OK' and the following window appears.
          

Note: This information can be amended after you import your bank file. To do this, from the 
file menu on the 'Reconciliation' window select Tools > Amend Bank Statement 
Details
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● Import transactions by selecting File > Import Bank Transactions from the menu.

The following window appears.
          

● Open the folder containing your bank file.

● Select the bank file you want to import from the list displayed, and click 'Open'.

The bank information is imported into the reconciliation window.
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● To restrict the transactions displayed, enter a date into the 'Bank Transactions to' box and 
'Sage Transactions to' box.

● Select the appropriate reconciliation method. We recommend that you use both the 
automatic and manual matching options. Use the automatic options to match the majority of 
the transactions, then use the manual method to match any outstanding transactions.

● Automatic match, transactions can be matched by amount or references or both (match 
full).

          

● Manual match, select a transaction from the bank transactions displayed and the 
matching transaction from the Sage transactions displayed, and then click 'Match 
Manual'. 

Note: If the routine finds several possible matches a 'Duplicate Transaction' window is 
displayed for you to make the final selection.
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● To save the matches made, click 'Confirm'. If you have set the routine to automatically 
confirm manual matches, confirmation is done automatically for you. For more information 
see Set the matching facility on page 152.

● To ignore all confirmed and matched transactions and start again, click 'Discard'.

● To complete the reconciliation process click 'Reconcile'.

Amend bank transactions

Provided a transaction has not been removed by the discard date option, it is possible to adjust 
its reconciliation status within the bank file. This is particularly useful if the corresponding 
transaction in the Cash Book has been adjusted using the manual reconciliation routine. You 
can:

● Reverse (unreconcile) a reconciled transaction.

● Reconcile a transaction that has been overlooked.
          

Access the window

Choose Period End Routines > Bank Reconciliation and access the bank account enabled for 
e-banking. From the Reconciliation form menu select Tools > Amend Bank Transactions. The 
following window appears.
          

Note: This activity involves making amendments to the transactions in the bank file, not the 
bank account in the Cash Book.
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Enter the details

● Select the transaction to be adjusted and click the required button to reconcile or unreconcile 
where appropriate.

● Click Save.

Delete imported transactions

We recommend transactions are only reconciled up to the end of the previous day. This ensures 
all transactions for the dates you intend to reconcile are fixed and you capture a complete record 
of transactions when you import your bank file.

If you reconcile using the current day's transactions there is the possibility that you will only 
partially reconcile the day's transactions. For example, if you reconcile on Tuesday lunchtime 
and include Tuesday's transactions, the next time you import your bank file, the e-banking 
software assumes that all of Tuesday’s transactions have been reconciled. If any additional 
transactions were posted on Tuesday afternoon they will not be included in the new import file. 
To overcome this situation you need to remove the processed transactions for the partially 
reconciled date before you import the bank file and reconcile the transactions again.

Access the window

Choose Period End Routines > Bank Reconciliation and access the bank account enabled for 
e-banking. From the 'Reconciliation' form menu select the Tools > Remove Processed Dates.
          

Enter the details

● Enter the date range for the transactions you want removed.

● Click 'OK'. The Reconciliation form removes the specified transactions from those 
displayed.
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Reconcile bank account for the first time if opening balances are posted 
to the account

We recommend the following method when using the 'Bank Reconciliation' routine for the first 
time if there are opening balances posted to the account.

          

● Access 'Bank Reconciliation' and enter the correct statement date based on your opening 
balance date. 

● Reconcile your opening balance transaction only (if you entered a reconciled opening 
balance and included unpresented transactions do not reconcile those unpresented items at 
this point).

● Choose to save the reconciliation and check the report produced. This is your main audit 
trail of your first bank reconciliation and should be stored.

It is important to keep a record of the bank account's actual opening balance, this is printed 
in the first generated report. When you start to delete reconciled transactions the value of the 
deleted transactions is added to the opening balance. Without the first report you cannot 
identify the actual opening balance.

● Access bank reconciliation to check that the statement opening balance has been updated 
with the correct opening balance.

● You can now continue to reconcile your bank account transactions as normal. See Reconcile 
Bank Account on page 91.

Note: If there is no opening balance on the account use the manual method, or, the electronic 
method of bank reconciliation.
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Query Your Bank Accounts

You can search your bank account information daily to find monies paid and received, as well 
as the overall balance on the account. The Cash Book helps you get to this information so you 
can determine the status of a bank account. It displays bank information at account and 
transaction level. You can also use this routine to view details of standing orders and direct 
debits associated with your bank accounts. 

All values are displayed in the operating currency for the bank account.
          

Account level 

The account level provides an overall status for the account and is viewed with the bank contact 
details. It displays the account status in terms of account balance and last statement date and you 
can also view statement balances for the account. When you view the account at this level you 
can invoke the bank’s website or send an e-mail to your bank contact if the web and e-mail 
addresses are valid. You can also add, amend or delete files which are attached to the account as 
well as view any text memos attached to the account.

Note: You cannot change bank details using this routine. For more information see Amend a 
Bank Account on page 36.
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Access the window

Choose Cash Book Enquires > Account Enquiry.
          

Enter the details

● Select the account you want to query.

● Choose the window you want to view: 'Contacts', 'Statement Balances', 'Memo' or 
'Attachments'.
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Transaction level

The transaction level provides a detailed breakdown of each transaction held on the bank 
account. So for example, you can select a bank transaction and see the customer or supplier 
entry associated with it or select a grouped bank transaction and view all the sales and purchase 
transactions associated with it. You can also see nominal and tax details associated with each 
transaction. 

You can sort the transactions by date once they are displayed on screen and then print the details 
of those you are interested in. You can also use the 'Find' button to search for a particular 
transaction.

Access the window

Choose Cash Book Enquiries > Transaction Enquiry.
          

Enter the details

● Select the account you want to query.
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● Select a transaction you want to query.

● Select the drilldown, 'Nominal', 'Tax' or 'Trader Transaction' to view the information you 
require.

          

● Click 'Close' to return to the previous window.

Standing order/direct debit level 

You can view the summary level details of standing orders and direct debits associated with 
your Cash Book bank accounts; this covers the references, first entry date, number of required 
entries and its description. You can then view further details to include the nominal accounts 
affected by the postings, the frequency and day of the month transactions are made and the 
actual transactions made to date.

The print facility generates a report detailing all active standing orders and direct debits for a 
bank account.

Access the window

Choose Cash Book Enquiries > SO and DD Enquiry.

Note: Drilldown details are only available if the transactions exist and have not been purged 
from the bank account files or the trader account files. For more information on 
drilldown see your Sage 200 Operations documentation.

cash book manual.book  Page 108  Tuesday, February 19, 2008  11:02 AM



Chapter 6 Manage Bank Accounts

109
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Prepare Bank Account Reports

This section describes the reports used to keep track of your bank accounts and their associated 
transactions. You can also use the enquiry routines to view bank transactions. For more 
information see Query Your Bank Accounts on page 105.

As with all reports you can view the report on screen, send it to the printer, store it to a file as 
either text, rich text or CSV format. You can export the content of a report to a spreadsheet, 
database or report generator, once it has been saved to file. You can even attach it to e-mail and 
distribute the report to other users.

The reports described in this section are the 'Account Details', 'Unpresented Cheques', and 
'Transactions Listing'.

Access the window

To prepare your report choose 'Reports' then select the report that you want to produce and 
follow the on screen instructions.

Account Details report

Use this report to print details of all bank accounts. Details can be printed in order of account 
number, name or foreign currency.

Transaction Listing report

Use this report to print the transaction history of a bank account.

Unpresented Cheques report

Use this report to print details of payments and receipts not yet included in a statement. It also 
shows the balance of the account up to the last statement and the current balance on the account.
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Delete Reconciled Transactions

It is important to delete reconciled transactions on a regular basis to ensure the volume of 
transactions on a bank account does not become too large and ultimately maintain the efficiency 
of the Cash Book.

The value of deleted transactions is added to the account’s opening balance. This maintains a 
running bank balance on the account. The routine uses a statement date, which is specified by 
you to identify reconciled transactions for deletion.
          

Access the window

Choose Other Transactions > Delete Transactions.
          

Enter the details

● Select the bank account you want to delete transactions from.

● Enter the date you want the routine to use to identify those transactions for deletion.

If there are no transactions identified for deletion the routine terminates and a message 
appears.

Outcomes

● The reconciled transactions which match the statement date are deleted.

● The bank account opening balance transaction is updated.

Note: We recommend you delete reconciled transactions before you close the current 
period. See Close Period End on page 115.
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7
Maintain Cash Book

This chapter covers the regular housekeeping routines 
needed to maintain the efficiency and effectiveness of 
your Cash Book.

It includes the routine used to identify the status of the 
Cash Book as a whole and covers the mechanisms 
employed to maintain the integrity of the data held in the 
Cash Book.

Activities:

Verify ledger balance

Close period end

Run year end
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Before you begin ...

You must have:

✔ Applied transactions to your bank accounts. For more 
information see Chapter 4, Manage Transactions and Chapter 
5, Manage Foreign Currency Transactions.

          

Remember ...

For more information on using the help system, see the Sage 200 
Operations documentation.

Note: You must have suitable security privileges to perform 
these activities. See your system administrator for more 
information.

cash book manual.book  Page 114  Tuesday, February 19, 2008  11:02 AM



Chapter 7 Maintain Cash Book

115

Perform Housekeeping Activities

To ensure your records are up to date and to optimise the processing speed on the ledger you 
need to perform regular housekeeping activities.

Verify ledger

The 'Balance Ledgers' routine is a preventative measure to identify actual problems on the 
ledger. You can use it to check all account balances on the ledger or just check a single account.

The routine checks several account elements such as postings and account balances to ensure 
they are valid. The routine produces a report, summarising the findings which you can use to 
identify if there are discrepancies. You can also use the routine to adjust imbalances and reset 
the account balance as part of the process.

It is good practise to run this routine on a regular basis to detect any problems. If problems are 
left undetected your backups and daily processing will be affected. It is also good practise to 
check the overall Cash Book balance matches the combined balances of each bank account.

You can only run this routine in single user mode; there must be no other users on the system.

You can access the 'Balance Ledgers' routine through the Accounting System Manager. For 
more information see your Sage 200 Accounting System Manager documentation.

Close Period End

This is vital to maintaining your Cash Book and as the title suggests is performed on a period 
basis in conjunction with the accounting periods defined in the Accounting System Manager. 

After closing the period in the routine 'Maintain Accounting Periods' in Accounting System 
Manager, the Nominal Ledger will no longer accept transactions for the closed period from the 
Cash Book. They will go into the next open period.

Closing a period end is performed in the Accounting System Manager. Whilst some of the 
preparation that you are required to do is within the Accounting System Manager, most of the 
preparation you need to do for closing a period end for the Cash Book is done within the Cash 
Book itself.
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Preparatory Tasks for Cash Book Period End 

Before you close a period end using 'Maintain Accounting Periods' in Accounting System 
Manager for the Cash Book you must have:

● Run the 'Update Pending Postings' routine on the Cash Book. For more information see 
Manage Pending Transactions on page 89.

● Reconciled bank accounts in the Cash Book.For more information see Reconcile Bank 
Account on page 91.

● Printed nominal postings reports in the Cash Book.

● Revalued foreign bank accounts in the Cash Book. For more information see Manage 
Exchange Rate Changes on page 83.

● Run the 'Process Standing Orders and Direct Debits' routine in the Cash Book. For more 
information see Process direct debits or standing orders on page 90.

● Taken a backup of your database.

● If you have not already done so, used the Accounting System Manager > System Utilities > 
Transaction Audit File option to print or store your transaction audit trail for the period. For 
more information see your Sage 200 Accounting System Manager documentation.

For more information about closing periods see your Sage 200 Accounting System Manager 
documentation.

Perform year end

The 'Year End' routine is controlled from within the Nominal Ledger. For more information see 
your Sage 200 Nominal Ledger User Guide.

Before you can run the 'Year End' routine you must have closed the period for the Cash Book 
for the final period for your financial year within Accounting System Manager. For more 
information see your Sage 200 Accounting System Manager documentation.
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Glossary of Accounting 
Terms

Defines frequently used accounting terms and terms found 
in Sage 200.
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Remember ...

... the Sage 200 help system also contains glossaries.

A
Account The generic term for a set of 

information relating to a 
supplier, customer, bank or 
nominal account record.

Account Balance The total value of money 
outstanding on an account at 
any one time.

Account Code The account code is made from 
three parts: the account number, 
the Cost Centre (CC), and the 
Department (Dep).

Account Name The account name associated 
with a nominal account code, as 
set up when you enter a new 
account. This will be displayed 
on certain forms by the system 
when you select a nominal 
account. 

Account Number The unique identifier that 
relates to a specific account. 
This can constitute numerical 
or alphabetic characters or a 
combination.

Account Type There are three types of 
account: automatic allocation, 
balance forward and open item. 
Selecting an account type 
determines how the 
transactions on the account are 
processed and stored.
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Accounting Equation The equation at the heart of double entry book-keeping, 
which states that the liabilities of a business subtracted from 
its assets equals its capital. It is the reason a Balance Sheet 
exists.

Accounting Period Status The accounting periods set up within the Accounting 
System Manager can have a 'Closed', 'Open' or 'Future' 
status. This accounting period status determines whether the 
Nominal Ledger can receive postings into the period.

Accounting Periods The divisions of the financial year, usually 12 or 13. The 
periods of time used by the business to process accounting 
entries when producing certain reports, such as the Profit 
and Loss and the Balance Sheet. See Open Accounting 
Periods.

Accounting System Manager The Sage 200 Accounting System Manager module allows 
you to set up common controls for applications across 
modules.

Accounts Payable See Purchase Ledger.

Accounts Receivable See Sales Ledger.

Accruals The process of matching expenditure or income to the 
accounting period in which it was incurred rather than paid; 
for instance, a rent cheque or utility charges.

Accumulated Profit Account This nominal account is where the Year End process puts 
the sum of the Debit-YTD and Credit-YTD figures from the 
Profit and Loss accounts before setting them to zero. On the 
'Year End' report, the Account/CC/DP and Name is shown 
and the final debit or credit amount calculated by the 
process.

Actual Cost The price paid for an individual item as it is invoiced in 
Purchase Order Processing and used to calculate the cost of 
stock. Only applicable for batch/serial numbered items.

Additional Charges Extra charges placed on an order, such as carriage and 
insurance.
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Adjustment Period A period opened after the Nominal Ledger year end has 
been run, to enter transactions to adjust the previous year's 
figures. When the adjustment period is closed, the 
transactions in this period are included in the opening 
balance for the current year.

Aged Creditors Aged Creditors are creditors to whom the business has owed 
money for a defined period of time.

Aged Debtors Aged Debtors are debtors who have owed money to the 
business for a defined period of time.

Aged Creditors Report The Aged Creditors report analyses amounts owed to 
suppliers according to the length of time those amounts have 
remained unpaid.

Aged Debtors Report The Aged Debtors report analyses amounts owed by 
customers according to the length of time those amounts 
have remained unpaid.

Ageing Date This is the date applied within the ageing reports. These 
reports provide details on the trader's account transactions 
for a specific ageing date.

Allocation Date This is the date a transaction is allocated. You enter the 
allocation date when you enter the transaction.

Allocation The process by which payments are matched against 
purchase invoices and receipts against sales invoices raised.

Allocation Status See Transaction Status.

Analysis Codes Analysis codes are used to indicate common sales or 
purchase accounts. Assigning an analysis code to a sales or 
purchase account allows you to group transactions for 
payment or for reporting purposes.

Appropriation Accounts These show how net profit is distributed between partners in 
a partnership or between share holders and reserve funds in 
a company.
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Assets The resources of a business; items it owns and uses, or 
amounts owed to it. Examples of assets are property, stock, 
cash and money held in the bank.

Attachments Any type of file (graphic, text, spreadsheet) associated with 
an account.

Auditor A person qualified to inspect, correct and verify business 
accounts.

Authorised Share Capital The total value of shares that the company could issue, as 
distinct from the called up and paid up share capital.

Automatic Allocation Automatic allocation is a type of accounting that combines 
the features of open item accounting with an automated 
allocation routine, which is activated at period end. During 
the period end process, any payments are allocated to 
invoices on the basis of the oldest outstanding invoices 
being allocated first. If an invoice is in query, then it is 
ignored.

B
Back to Back Order

The generation of purchase orders to satisfy sales orders 
when using the 'From supplier via stock' fulfilment method.

Bad Debt A debtor who is not expected to discharge his debt. Bad 
debts must be written off and hence reduce profit.

Balance The total amount of money outstanding on an account at any 
one time.

Balance Forward Accounting Balance forward accounting is a type of accounting where 
all transaction details remain on the ledger in full until the 
Period End routine is run. During the period end procedure, 
all transactions (except those 'in query' which are dealt with 
separately) are cleared from the file and only a brought 
forward balance is displayed for the new period. Each 
period's total creditors balance is carried forward as a single 
balance figure. The number of balances carried forward 
depends upon the number of periods aged debts you specify 
for the Purchase Ledger. 
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When transactions, such as receipts, are posted for a 
previous period's transaction, they are allocated by period 
number, so that the appropriate balance is reduced at the 
period end. The advantage of this type of accounting is its 
economical use of disk space, which if short on your 
computer, may influence your choice of accounting method. 
Balance forward accounting cannot be used for foreign 
currency accounts.

Balance Ledgers A routine that ensures all data stored for a Sage 200 module 
is intact and has not become corrupted in any way.

Balance Sheet A report that details the various assets and liabilities of a 
business at a point in time, usually the end of an accounting 
period. A Balance Sheet must always balance; debits must 
always equal the credits.

Bank Account Type Bank accounts may be deposit or current. Deposit accounts 
are for holding monies longer term, when transactions are 
not made as regularly as they are for current accounts. 
Standing orders and direct debits cannot be set up on deposit 
accounts.

Bank Charges Bank charges can be incurred for many reasons. For 
example, if trading in foreign currency, you may incur 
charges as a result of the conversion to the bank account's 
currency. You may enter these in the Sales/ Purchase Ledger 
and Cash Book transaction entry routines. These charges are 
then posted to a bank charges account (profit and loss) 
within the Nominal Ledger.

Bank Payment A transaction posted that reflects the payment for goods or 
services.

Bank Receipt A transaction posted that reflects the receipt of money for 
goods or services.

Base Currency The currency normally used by the Sage 200 user's company 
to carry out business transactions.

Base Unit Used to determine the ratios that are applied to calculate the 
quantitative relationships between an item's units of 
measure.
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Batch Numbered Item A standard stock item assigned batch numbers, enabling a 
group of stock items to be traced from purchase through to 
sales.

Batch Processing A method of accumulating and processing transactions 
together in a batch.

Bill of Materials (BOM) A stock assembly and process costing system, which 
provides facilities to specify the structure of finished items 
in terms of sub-assemblies and components.

Bin Secondary location point where a stock item is stored. The 
bin is the default secondary location provided with Sage 200 
when using multiple locations.

BOM See Bill of Materials.

Budget An estimate of expected income or expenditure for expected 
activities over a specified period of time.

Buying Price Unit The measure in which a purchased item is priced.

Buying Unit The measure an item is bought in, such as metre, litre, case.

C
Call When shares are issued only part of their cost is usually paid 

at the time of application and allotment. A call is a demand 
by the company for part or all of the outstanding sums to be 
paid.

Called Up Share Capital The face value of shares for which payment has been called, 
although not necessarily made.

Capital Amounts owed by a business to its owners, being the 
amounts injected in cash by the owners, together with any 
movement in the value of the business not made up by 
further cash injections or withdrawals.

Capital Employed Capital generally defined as the money invested in the 
business. Shareholder's capital employed refers to share 
capital and reserves only, whereas total capital employed 
includes long term loans.
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Capital Expenditure Money spent on the acquisition of an asset, such as 
premises, motor vehicles, plant or machinery that are used 
within the business over a period of years.

Capital Gain Profit made on selling an asset for more than its original 
purchase price.

Capital Gains Tax Tax paid on the capital gain (profit) made on selling an asset 
for more than its original purchase price.

Capitalisation The accounting process by which expenditures of the 
business relating to more than one accounting period are 
created as assets, so that they can be released to the Profit 
and Loss report in instalments over the accounting periods 
to which they relate.

Cash Book A book used to record details of cash moving in and out of 
the bank accounts.

The Cash Book module lets you post cash transactions to 
nominal bank accounts and appropriate revenue and 
expense accounts.

Cash Flow A measure of the liquidity of a business that concentrates on 
cash in and out rather than accounting profits and losses. 
Profitable businesses can fail if customers pay more slowly 
than the business pays its suppliers, and so cash flow, as 
well as profitability, should always be measured.

Cash Flow Forecast A forecast of the liquidity or cash in and out of a business.

Cash Payment A transaction posted that reflects the payment for goods or a 
service where there has either been no invoice (for example, 
buying petrol for a car where the money is handed over 
immediately the goods have been received), or the invoice is 
paid as soon as it is received thereby removing the need to 
post an invoice through the ledger. Instead of the money 
being paid directly out of the bank, the money is paid out of 
either the petty cash account or till account. 

Cash Receipt A transaction posted that reflects the receipt of money for 
goods or a service where there has been no invoice (for 
example, selling goods over the counter, the money is 
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handed over immediately the goods have been received) or 
the invoice is paid when it is received thereby removing the 
need to post it through the ledger. Instead of the money 
being paid directly into the bank, the money is paid into 
either the petty cash or into the till account. 

Chart of Accounts A list of all the categories a business uses to analyse income, 
expenditure, assets, liabilities and capital, together with the 
way such categories are assigned to the Balance Sheet or 
Profit and Loss financial statements.

Closed Accounting Period The 'Closed' status means that the Nominal Ledger is not 
able to receive transactions from specific source modules 
for the accounting period that has been closed. 

Closing Balance The balance of an account at the end, or close, of an 
accounting period.

Commercials Modules Commercials modules within Sage 200 comprise the Stock 
Control and Sales and Purchase Order Processing modules.

Contra Entry An adjustment made to balance transactions in one ledger 
with another. For example, outstanding purchase ledger 
transactions may be balanced against outstanding sales 
ledger transactions where you sell to and buy from the same 
company.

For example, you have sold goods to XYZ of the value of 
£200. You have bought goods from XYZ to the value of 
£100. Overall they owe you £100 (i.e. what they owe you 
less what you owe them). A contra entry matches up the 
£100 you owe them against £100 they owe you.

Control Accounts Accounts to which single balances analysed elsewhere in 
the accounting system are posted. Often the balances are 
posted from other ledgers. For example, the debtors control 
account records the amount of sales recorded in Sage 200. It 
is reduced by receipts from customers as they are posted 
into the system.

Consolidation The process of combining the Nominal Ledger information 
for a set of different companies, where one is the main 
company and the other(s) subsidiaries.
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Cost Analysis A review and evaluation of costs.

Cost Centre (CC) A segment of an organisation for which costs are required to 
be collected and formally reported on separately; for 
example, a company division such as sales or production.

Cost of Sales The direct costs incurred as a result of making sales. For a 
retail company, this may mean the cost of purchasing goods, 
net of carriage and purchasing discounts, less the movement 
in the value of the stock. For a manufacturing company, it 
may mean the cost of producing the goods sold.

Cost Plus A job charged as the value of materials and labour uplifted 
by a percentage.

Cost Variance The difference between the actual cost paid for an item and 
the declared standard cost specified on the stock item.

Country Codes EC countries each have a specific code to identify accounts 
that belong to that country. These have implications for 
VAT processing. The VAT implications of trading in EC 
countries are described in the Sage 200 Accounting System 
Manager documentation.

Credit (1.) One side of the double entry process, representing 
negative figures on the Balance Sheet (reductions in assets; 
increases in liabilities and capital), and income on the Profit 
and Loss financial statements.

(2.) Assumed money a customer may use to purchase goods 
from you. This is normally dependent on their history with 
you. Limits are usually set and credit can be withdrawn at 
any time if the customer fails to pay or goes beyond the 
agreed credit limit.

Credit Control The process of monitoring and reporting on accounts where 
money is owed to the business.

Credit Limit The amount an account is allowed to owe at any one time. 

Creditors Third parties to whom money is owed by the business.
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Criteria Allow you to narrow down the amount of data displayed on 
a Sage 200 report. When you request a report within Sage 
200, you will often be presented with the 'Criteria' window 
if it is relevant to the report. You can accept the default 
criteria, which will usually select all possible records, or you 
can select the output for the report by entering selections. 
The criteria offered will depend on each report.

CSV Comma Separated Value file format. Sage 200 can import 
and export data in the CSV file format.

Currency Adjustments A gain or loss which emerges as a result of the difference in 
exchange rates between the time an invoice was issued on 
foreign currency accounts and payment was made.

Current Account Balance The total value of money outstanding on an account at that 
time.

Current Asset An asset which can be easily realised. It can also be termed 
a liquid asset; for example, money in the bank or in petty 
cash, debtors or stock.

Current Liability A current liability is a debt owed by the company; for 
example, creditors, accruals or an overdraft that will be 
cleared in the short term.

Current Postings These are postings that are waiting in the Nominal Ledger 
current postings file, ready to be updated to the accounts in 
the 'Update Waiting Postings' routine. These postings have a 
transaction date earlier than the current Nominal Ledger 
period end date.

Current Transactions These are the transactions that have not yet been removed 
from the account by closing the period. The length of time 
these remain on the account depends on the setting 'Keep 
Transactions For' in the module 'Ledger Settings'.

Customer and Supplier 
Analysis Codes Codes used to group transactions on sales and purchase 

accounts according to a defined common attribute which 
can subsequently be used as report selection criteria.

D
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Data File Synonymous with company in Sage 200. A Sage 200 data 
file is a Sage 200 company.

Day Book A book that lists all the transactions in the order that they 
arise. There is a day book for different types of transactions, 
for example, a sales day book and a purchase day book.

Debit One side of the double entry process, representing positive 
figures on the Balance Sheet (increases in assets; reductions 
in liabilities and capital), and expenditure on the Profit and 
Loss financial statement.

Debtors Third parties from whom money is owed to the business.

Debtors Control This is the balance sheet account to which postings are made 
when transactions are added to the Sales Ledger. For 
example, when you post an invoice, the total value of the 
invoices is debited to the debtors control account, while the 
sales analysis account is credited with the net goods value 
and the VAT output account is credited with the VAT 
amount.

Default Values Settings that are used for all accounts unless specifically 
overridden at account level.

Deferred Postings Postings whose transaction date is after the current Nominal 
Ledger period end date. These are stored in the deferred 
postings file and will not be updated into the ledger during 
the 'Update Waiting Postings' routines, as current postings 
are. Closing the period moves postings from the deferred 
file to the current one when their transaction date becomes 
earlier than the new period end date.

Delivery Note Sent to the customer with goods to show what should be on 
the order. The recipient will normally sign to prove the order 
has been fulfilled. The document is retained in case of any 
future dispute.

Department (DP) A subdivision of a cost centre where costs are required to be 
collected and reported on separately; for example, a sales 
area or a manufacturing depot.

cash book manual.book  Page 128  Tuesday, February 19, 2008  11:02 AM



Chapter 8 Glossary of Accounting Terms

129

Direct Expenses Those expenses that are incurred in the actual manufacture 
and sale of the product or the sale and provision of the 
service (the expenses incurred by the business actually 
trading).

For example, the wages of machine operators, the power to 
run the machines, the wages and commission of sales staff, 
the cost of advertising and any sales promotions.

Discount A reduction in price allowed to a customer for loyalty, early 
payment or bulk buying.

Direct Debit A recurring bank transaction. The first and last payment 
amounts may differ from the regular payment. They may be 
subject to VAT and the frequency of payment may be 
weekly, monthly, quarterly or some other specified period. 
As with standing orders, the necessary payment or receipt 
transactions are automatically posted using either a daily or 
monthly routine.

Direct Delivery The ability to deliver goods directly to the customer based 
on the sales orders they raised, or deliver to a customer, 
supplier or other location not related to an initial sales order.

Dispute Codes Codes used to mark purchase invoices as disputed.

Distributable Profits In company accounts these are the sums that are available 
for dividends to shareholders. While based on the net profit, 
they may be increased by undistributed profits from the 
previous year or reduced by the need to retain some for the 
reserves.

Dividend The amount paid out per share. Usually described as a 
percentage of the face value (the original price) of one share. 
So a 10% dividend on a £1.00 share would be 10p.

Double Entry A system of book-keeping in which every transaction of a 
business is entered as a debit in one account and as a credit 
in another. As every transaction must have an equal or zero 
effect on both sides of the accounting equation, every 
positive amount entered (debit) must be mirrored by a 
negative amount or amounts (credit).
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Drawings Cash or goods taken from the business for the owners 
personal use. Drawings only apply to sole traders and 
partnerships. Drawings do not count as an expense in the 
Profit and Loss financial statement and must be included in 
the 'financed by' section of the Balance Sheet.

Due Date The date by which an invoice should be paid. This is used 
for the Aged Creditors or Aged Debtors reports.

E
EC Country A country that is in the EC trading area, identified by its 

country code. These countries are required to follow specific 
trading procedures. The VAT implications of trading in EC 
countries are described in the Sage 200 Accounting System 
Manager documentation.

Equity The money invested in a business to get it started, together 
with any subsequent cash investments net of withdrawals 
(the interest of ordinary shareholders in a company).

Euro Currency in Transition This is a currency which has joined the euro but is in a 
period of transition. During a transitional period both the 
euro and the country's currency may be used to trade 
simultaneously.

Exchange Differences When trading in foreign currencies, changes in exchange 
rates may affect the profit and loss on a transaction. These 
exchange differences are posted to the Nominal Ledger 
'Exchange Differences' account.

Exchange Rate The calculation a bank will use to convert the price of one 
currency into another currency. Whilst some exchange rates 
are fixed by agreement, most change daily.

Expenses Expenses are those items that the company buys which do 
not go to actually create that company's product or service. 
For example, stationery, petrol, promotional goods.

F
Factor House A third party company that collects a supplier's debts on 

their behalf.
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Factored Pricing Allows one stock line to be bought, sold and held in stock 
varying units.

For example, aluminium wire could be bought in 2000m 
lengths, sold in lengths of 100m, 200 m and 300 m but may 
be held in stock in 1000 m coils. Factored pricing allows 
you to convert the buying and selling prices from one unit to 
another, where required.

FIFO FIFO, or First In First Out, is an assumption that enables the 
cost of stock to be calculated. When sales are made the 
items sold are assumed to be the earliest purchased, so the 
cost of items in stock always reflect the most recent 
purchases.

Finance Charges Charges applied to customers who fail to pay within the 
time agreed. The charges may escalate depending on the 
length of time bills are unpaid.

Financials Modules Financials modules within Sage 200 comprise Sales, 
Purchase and Nominal Ledgers and the Cash Book.

Fixed Assets Assets which the business intends to retain for the coming 
year rather than convert into cash. Typical fixed assets 
include property, office equipment and motor vehicles.

Fixed Price The cost of the job is decided up front and is not based on 
what it has actually cost to complete the job.

Foreign Currency Any currency other than base currency, in which an account 
operates. Currency processing implications are described in 
the Sage 200 Accounting System Manager documentation.

Free of Charge Issue Issuing stock to customers where no charge is made for the 
goods.

Free Stock The amount of unallocated stock available at a given place, 
where place can be a location, warehouse or warehouses.

Free Text Item Items that have not been defined in the Stock or Sales Order 
Processing module, and which may have lengthy descriptive 
text to be included in a quotation, pro forma invoice or 
order.
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Full Order Entry Orders for account customers in Sage 200 Sales Order 
Processing system. Goods ordered in this way are 
despatched from the warehouse with a despatch note, and an 
invoice for payment is generated separately. Such orders 
may be subject to discount. Some payments may be received 
and entered at the same time as the order.

Future Accounting Period Periods marked with a 'Future' status cannot receive any 
postings. Any transactions posted onto the Nominal Ledger 
with a date in the future are deferred until the period is 
opened.

G
General Ledger See Nominal Ledger.

Goods Received Number 
(GRN) The Goods Received Number, also known as GRN, is 

assigned to a record when goods or services are confirmed 
as received. It is also applied to a record when goods are 
returned to a supplier during the Confirmed Goods Returned 
activity.

Goodwill An intangible asset of a business reflecting its commercial 
reputation and customer connections.

Group Accounts These are used to group Nominal Ledger accounts for 
reporting purposes only.

Gross The amount before any deductions are made.

Gross Margin A measure of the profitability of a business by which the 
gross profit is divided by the sales. It is usually expressed as 
a percentage.

Gross Profit The difference between total revenue from sales and the 
total cost of purchases or materials, with an adjustment for 
stock.

H
Held Journal Entry Journal entries that have not yet been completed are called 

held. They are stored in a special file until such time as they 
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are completed, when the postings within each journal entry 
will be moved either to the current or deferred postings files 
depending on their posting date. Entries may be held for 
several reasons; for example, the entered postings do not 
balance and further investigation is required, or 
authorisation is required from another user.

Historical transactions These are transactions that have been transferred to the 
historical transactions file which is controlled by settings 
within each module.

Honorarium A voluntary fee paid for a service that is usually free.

I
Intangible Assets Assets, especially fixed assets, can be considered as tangible 

and intangible; tangible assets are physical entities, whereas 
intangible assets are conceptual. Intangible assets include 
copyrights, patents, goodwill. They are saleable but do not 
contain any intrinsic productive value.

Internal Issue Issuing stock items requested by an internal department.

Intrastat Supplementary Statistical Declarations (SSD), are necessary 
for VAT registered businesses with a value of despatches of 
goods to other EC countries or of arrivals of goods from 
other countries exceeding a threshold.

Inventory Management The process of managing your stock control.

Invoicing The process of billing for payment.

J
Job Costing A cost accounting system, which allocates costs to specific 

jobs. 

Journal A record that holds one or more transactions for posting. 
Synonymous with batch in batch processing.
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Journal Entries Double entry transactions that can only be entered directly 
in the Nominal Ledger module. These can be corrections to 
postings from the other ledgers or additional transactions 
that do not relate to the other ledgers.

L
Landed Costs The costs incurred in shipping and handling products can be 

calculated separately from the product costs and logged to a 
separate Nominal Ledger account. If you choose to do this 
in Sage 200 you can maintain and track your shipping, 
handling and any importation costs independently.

Ledger Date This dictates the end of the current period being processed. 

Ledgers The principal book in which the transactions of a business 
are recorded. The details of customers and their transactions 
are recorded in the Sales Ledger; purchasers and their 
transactions are recorded in the Purchase Ledger. All 
ledgers are amalgamated in the Nominal Ledger by the 
posting of balances from the individual ledgers. The 
Nominal Ledger also receives postings from the Cash Book 
and directly from journal entries for all other accounting 
transactions.

Liabilities Amounts owed by a business to third parties including 
suppliers, banks, tax authorities and employees.

Liquid Asset See Current Asset.

M
Margin The purchase and sale of a goods item may be shown as 

Cost Price + Profit = Selling Price. The profit when 
expressed as a fraction or percentage of the selling price is 
known as the margin.

Mark-up The purchase and sale of a goods item may be shown as 
Cost Price+Profit=Selling Price. The percentage added to 
the cost price to provide a profit is known as the mark-up.

Memo Free format text entered against a specific account.
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Memorandum Accounts Whenever you are posting transactions to the Nominal 
Ledger using the journal entry facilities, the total of all 
postings in the batch needs to balance to ensure accurate 
double-entry bookkeeping. However, any value associated 
with a memorandum account does not affect either the debit 
or credit total of the journal. This enables you to analyse 
values in more than one way without affecting the balance 
of accounts or the ledger as a whole.

Module A term which denotes features based in and around an area 
of accounting. For example, sales are described and 
contained within the Sage 200 Sales Ledger module.

Month End A specific processing routine available for each Sage 200 
Financials module.

Multiple Locations Used when stock is stored in several different places; for 
example, warehouses and bins.

Multiple Units Used when stock is bought, stored and sold in different 
measures; for example, cases and bottles.

N
Net The amount that remains after all deductions have been 

made.

Net Book Value The original value of the asset less any depreciation charged 
to date.

Net Profit This is calculated as gross profit less expenses.

Net Realisable Value The amount that would be received for the immediate sale 
of stock, after accounting for any costs associated directly 
with the sale.

Net Worth The value of a business as represented by subtracting its 
liabilities from its assets.

Nominal Account An account within the Nominal Ledger used to collect costs 
or revenue for inclusion on the Profit and Loss and/or 
Balance Sheet financial statements.
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Nominal Ledger This ledger is updated by most of the transactions posted in 
all ledgers. It is the core of the accounting process. The 
balances on all of the nominal accounts make up the Trial 
Balance and therefore the Profit and Loss and the Balance 
Sheet financial statements.

Non-productive The job is not invoiced to anyone. The cost is recorded for 
the company's own reference only.

Non-trading This refers to nominal accounts and transactions that do not 
relate to the Sales or Purchase accounts.

Non Traceable Item Any stock item not set to use batch/serial numbers and 
therefore cannot be traced from purchase through to sales. 

O
On Hold Flag An indicator that an account is in a query status for some 

reason. This prevents certain processing against this account 
until the flag is cleared.

Open Accounting Periods Sage 200 now enables the system to have up to 20 
accounting periods open at the same time. This status allows 
the Nominal Ledger to receive transactions from the source 
modules chosen. If more than one period is open at the same 
time, Sage 200 uses the date of the transaction to determine 
which open period will receive the posting.

Opening Balances The balance of an account when it is initially opened, or the 
balance carried over from the previous accounting period 
(the closing balance).

Open Item Accounting Open item accounting is probably one of the most widely 
used methods for computerised accounts. It enables all 
outstanding transactions to remain visible on the account 
record, until such time as they are allocated and removed 
when the period is closed. Transactions, such as invoices, 
paid when payments are posted to the ledger, can be 
specifically allocated to the individual transaction to which 
they relate. 

Provided the whole outstanding transaction is allocated in 
this way, the Period End routine removes it, freeing disk 
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space for new transactions. The details of the transactions 
however, remain on file until period end. All outstanding 
amounts, whether they are part allocated payments, disputed 
transactions or unpaid or part-paid invoices, remain on the 
ledger from one period to another, showing full details, until 
such time as they are fully allocated, and have exceeded the 
time limit denoted in the ledger setting 'Keep transactions 
for'. For more information see your Sage 200 Sales Ledger 
and Sage 200 Purchase Ledger documentation.

Operating Currency Although the Nominal ledger only operates in your base 
currency, the trading accounts and bank accounts can 
operate in other currencies, as long as these are set up in 
your currency table in the Accounting System Manager. The 
currency each account uses is called their operating 
currency.

Operating Profit This is calculated from gross profit, less the expenses 
incurred in trade. It will be the same as the net profit unless 
the business has other income from investments or 
expenditure on loan interest. These items are not considered 
in calculating the operating profit.

Order Acknowledgement Raised once an order has been received to confirm with the 
customer that you are able to fulfil the order. An order 
acknowledgement will show the items along with 
confirmation of prices.

Order Line The requested goods or services in an order, covering 
standard items, free text items, additional charges and 
comments.

Order Processing Activities based around administrating orders and seeing 
them through to shipment or production.

Overdraft A bank facility that allows customers credit with the bank so 
that the customer can use money that they do not currently 
have available.

Overheads Business expenses, such as rent, that are not attributable 
directly to any department or product and can therefore be 
assigned only arbitrarily.

cash book manual.book  Page 137  Tuesday, February 19, 2008  11:02 AM



Sage 200 Cash Book

138

Overtrading Engaging in more activities than can be properly financed 
by the company. This can often lead to bankruptcy and 
liquidation.
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P
Paid Up Share Capital That share capital for which all payments have been called 

up and made.

Payment Method Used to define the payment types and capture payment 
values made at the point of sale within Sales Order 
Processing. 

Payment Terms These are the number of days agreed with a customer or 
supplier before an invoice must be paid.

Pending Transactions Transactions that have not yet been posted to the ledgers. If 
a transaction is on hold (has an on hold flag entered against 
it) it remains pending until it is released for payment. See 
Transaction Status.

Period The accounting period associated with a transaction. This is 
usually a calendar month within a year.

Period End Routines Specific processing routines required for each Sage 200 
module, such as the Close Period routine.

Phantom Item An item created from a bill of materials (BOM). They are 
finished items that you would not sell to your customers or 
keep in stock. They are typically used to segment large 
BOMs and to assist in planning how to build a finished item. 

Picking List A list that can be printed to support the sales order despatch 
process. The list details the stock items and where they are 
stored.

POP See Purchase Order Processing.

Posting The processing of an accounting transaction.

Posting Accounts These are the only types of account to which a posting may 
be made which is reflected in the trial balance and other 
financial statements. This includes all the accounts of the 
profit and loss and balance sheet.

Posting Date This is the date you post a transaction to the ledger or to the 
posting file. For example, if a transaction is posted to the 

cash book manual.book  Page 139  Tuesday, February 19, 2008  11:02 AM



Sage 200 Cash Book

140

waiting or pending posting file on one date and then updated 
to the ledger on another date, it is the first date which is 
classed as the posting date.

Generally this is the same as the allocation date but if you 
give transactions an allocation date that is different from the 
system or today's date (for example, allocate the 
transactions retrospectively or put an account on hold), the 
posting date is the system date when the transaction is 
physically posted and so will be later than the allocation 
date.

Prepayments The process of deferring expenditure and income to the 
accounting period in which it is incurred. This usually 
involves setting up an asset on the Balance Sheet for bills 
paid in advance, and then releasing that asset by instalments 
to the accounting periods in which the service is actually 
provided.

Pre Receipt Specific to batch/serial numbered items that are set to permit 
negative stock levels, allowing the item to be allocated when 
there is insufficient stock available. A pre receipt is, in 
effect, a shortfall for the item that is satisfied when more 
stock is recorded into Sage 200.

Price Band A way of offering different sales prices on items to different 
groups of customers. You define the price bands and then 
specify which customers belong to each band. 

Price Book An Sage 200 module which allows extensive flexibility and 
control over prices and discounts.

Primary Location Primary location point where a stock item is stored. The 
warehouse is the default primary location provided with 
Sage 200 when using multiple locations.

Product Group A group of stock items of similar type and processing 
requirement.

Profit The excess of revenues over outlays and expenses in a 
business.

Profit and Loss on Exchange See Currency Adjustments.
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Profit and Loss Financial 
Statement A report that categorises the income and expenditure of a 

business over an accounting period. The profit (or loss) of a 
business is its income less its expenditure; profit is analysed, 
along with gross profit (sales less the cost of those sales) and 
net profit (all income less all expenditure, before and after 
tax has been deducted).

Pro Forma Invoice A request for payment before a service has been carried out. 
Most commonly used for new customers or those who are 
potential bad debtors.

Provision for Bad Debt An amount put by for those debts which may not be paid. It 
appears as an expense on the Profit and Loss financial 
statement and is deducted from the debtors control account.

Purchase Credit Notes These are issued by suppliers in order to cancel purchase 
invoices either in full or in part. They are normally issued 
when goods or services are faulty or when the purchase 
invoice was incorrect. 

Purchase Discounts Purchase discounts may be given for a variety of reasons: 
buying in bulk, spending large amounts, being a preferred 
customer or settlement discount. 

Purchase Invoices These are issued by suppliers as a request for payment in 
respect of the supply of goods or services. 

Purchase Ledger The Purchase Ledger keeps track of all invoices, credit notes 
and discounts sent to you by suppliers. It can be quickly 
referred to if you want to find the current status of any of the 
supplier accounts. The total balance outstanding should 
equal the balance of the creditors control account in the 
Nominal Ledger.

Purchase Order Processing The administrative functions based around processing 
purchase orders. Purchase orders are documents that state 
the quantity, description and price of goods and services 
ordered, agreed terms of payment, discounts, delivery and 
all other agreements pertinent to the purchase and its supply.
The Sage 200 Purchase Order Processing module is where 
you can manage and track your purchase orders.
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Purchase Payments Payments made to suppliers in respect of invoices for the 
goods and/or services supplied. 

Q
Quick Ratio The liquid or quick ratio is current assets less stock to 

current liabilities.

Quotation A statement of the current market price of a security or 
commodity.

R
Rapid Order Entry A fast track method of order entry in Sage 200 Sales Order 

Processing system. Orders are quickly keyed into the system 
using default prices and discounts for the customer, which 
you can change if you have the appropriate user permissions 
to allow you to do this. 

Ratio Analysis Technique for analysis of the business by comparing 
selected figures from the accounts.

Reconciliation The process of agreeing accounting entries from one source, 
with entries from another source. The most usual 
reconciliation is a bank reconciliation, which matches 
transactions posted against a bank account with the 
statement received from the bank.

Recurring Journals Journals set up once in the Nominal Ledger, which run 
automatically each financial period thereafter, according to 
the financial period specifications which have been set for 
the journal.

Report Category For final accounts production, this is used in conjunction 
with the category. A single character code determines 
whether the account is a profit and loss item (P) or a balance 
sheet item (B).

Reserves Movements in the value of a business not made up directly 
from cash injections and withdrawals. Principally, they 
reflect the net profit or loss of a business, together with any 
unrealised changes in the value of its assets.
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Retention An amount of money retained by a customer for a specified 
period of time after a service has been provided, to ensure 
that if anything should subsequently go wrong then it will be 
rectified.

Retrospective Aged Creditors/
Debtors Reports The Retrospective Aged Creditors and Debtors reports show 

outstanding balances on each account, aged over the periods 
specified, compared with a specific ageing date.

Returns Goods returned to the business by a customer, or by the 
business to a supplier.

Revaluation A calculation to find the current base currency value of a 
transaction carried out in a different currency. This 
calculation produces different results at different times 
because of fluctuating exchange rates.

Reverse Transaction A method of removing a transaction to correct an error, for 
example. 

S
Sale or Return Goods supplied on the understanding that if not sold on (by 

the customer/retailer) they may be returned without charge. 
Such transactions are best not recorded in the accounts, until 
the actual sales figures are known.

Sales Credit Notes These are issued to customers in order to cancel sales 
invoices either in full or in part. They are normally issued 
when goods or services are faulty or when the sales invoice 
was incorrect.

Sales Discounts Sales discounts may be allowed for a variety of reasons; for 
example, buying in bulk, spending large amounts, being a 
preferred customer or settlement discount. 

Sales Ledger The Sales Ledger keeps track of all invoices, credit notes 
and discounts sent to customers and all receipts received 
from customers. It can be quickly referred to if you want to 
find the status of any of the customer accounts. The total 
balance outstanding should equal the balance of the debtors 
control account in the Nominal Ledger.
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Sales Order Invoice VAT invoice sent to the customer, usually after goods have 
been dispatched. It lists the items received, including 
quantity, prices and any discounts.

Sales Order Item A simple type of stock item, created and maintained in the 
Sales Order Processing module. There is no concept of stock 
quantity or stock level control associated with these items, 
and it is not possible to allocate these items.

Sales Order Processing The administrative functions based around processing sales 
orders. Sales orders are documents that state the quantity, 
description and price of goods and services ordered, agreed 
terms of payment, discounts, delivery and all other 
agreements pertinent to the sale and its supply.

The Sage 200 Sales Order Processing module is where you 
can manage and track your sales orders.

Sales Receipts These are made when invoices are paid off by the recipient 
of the goods or services. 

Secondary Location Secondary location point where a stock item is stored. The 
bin is the default secondary location provided with Sage 200 
when using multiple locations.

Serial Numbered Item A standard stock item assigned serial numbers enabling 
single stock items to be traced from purchase through to 
sales.

Settings Settings that control the way your Sage 200 modules 
operate.

Settlement Concluding a sales or purchase contractual agreement by 
payment of debt outstanding.

Shortfall An item's stock level that falls below zero. This can occur 
when the item permits negative stock levels, allowing the 
item to be deployed when there is insufficient stock 
available.

SOP See Sales Order Processing.
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Source Modules The Sales Ledger, Purchase Ledger, Cash Book and Stock 
modules are all referred to as source modules because they 
are a source for the transactions accepted by the Nominal 
Ledger.

Standard Item Stock, miscellaneous, or labour or service item, used to 
specify goods or services required on an order. 

Standing Order A recurring bank transaction in which a specified amount is 
paid from the bank account to an expense account for a 
definite number of periods. Standing orders may include 
VAT and may be processed on a daily or ad hoc basis.

Stock The total goods or raw materials held by a business for the 
purpose of resale. Stock is valued in the balance sheet at the 
lower of cost or net realisable value.

The Sage 200 Stock Control module is where you record 
stock details and track stock levels.

Stock Unit The unit of measure used to count the quantity of an item in 
stock.

Subcontractor An individual who works on a job but is not employed 
directly by the company. There are two types of 
subcontractor: those who hold a certificate entitling them to 
handle their own income tax, and those who do not. Those 
with a certificate would not be set up on the company's 
payroll but would invoice the company direct and normally 
appear as a supplier in the Purchase Ledger. Those without a 
certificate would have their income tax deducted at source 
via the company's PAYE scheme. In both cases the cost of 
employing a subcontractor is charged directly to the job.

Supplementary Statistical 
Declarations See Intrastat.

Surcharge The opposite of discount, resulting in an increase in order 
value.
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Suspense Account The nominal account automatically updated when an invalid 
account is specified for a transaction. It is also used when 
you are unsure what to do with a value. The suspense 
account can be used as a holding account until you decide 
what to do with the value. The balance on the suspense 
account should ultimately be zero.

T
Tax Tax, normally referred to as Value Added Tax in the UK or 

Irish VAT in the Republic of Ireland, may be applied to 
sales and purchase transactions in certain circumstances. 
These circumstances are described in the Sage 200 
Accounting System Manager documentation.

Time and Materials The cost of the job is the value of materials and labour 
attributed to the job.

Traceable Item A batch/serial numbered item enabling stock items to be 
traced from purchase through to sales.

Trade Counter Entry Simple order entry in Sage 200 Sales Order Processing 
system. This is associated with over the counter sales. The 
customer picks the goods, pays immediately and you then 
ship the product. 

Trade-ins An asset part-exchanged for another asset. This involves a 
sale and a purchase. The asset being sold has a net book 
value at the time of sale. If the selling price is more or less 
than this value, a profit or loss on sale is accounted for in the 
Profit and Loss financial statement.

The selling price of the asset being disposed of is offset 
against the asset being acquired, the difference being paid to 
the supplier of the new asset.

Trading Account Compares sales, stock used, and direct expenses to find the 
profit or loss made by simply buying and selling.

Transaction A record of an exchange between one party and another, 
normally between your company and another company, 
usually a customer or a supplier.

cash book manual.book  Page 146  Tuesday, February 19, 2008  11:02 AM



Chapter 8 Glossary of Accounting Terms

147

Transaction Analysis Codes Codes used to group items for reporting analysis.

Transaction e-Mail A mechanism for sending and receiving order 
documentation using e-mail to support the order process in 
Sales Order Processing and Purchase Order Processing. 

Transaction Status Refers to the status of the transaction. Can be one of the 
following:

Blank - nothing is allocated.

Part - some of the transaction amount has been posted to the 
ledger.

Full - all of the transaction amount has been posted to the 
ledger.

Trial Balance A list of all the nominal accounts at a given time, together 
with their net balances, shown as either a debit or a credit 
balance. The double entry book-keeping system, if 
completed correctly, requires that the total of all debits 
equals the total of all credits. The balances should always be 
equal.

Triangulation If you are using a foreign bank account but the payment or 
receipt currency is different to both the bank currency and 
your base currency, triangulation has to take place via your 
base currency, to determine the exchange rate to be used for 
the transaction. The rate from each currency to the base 
currency is amalgamated to produce an overall conversion 
rate that is then used to convert the transaction amount.

When a transaction involves a transitional euro currency (a 
currency that has agreed to move to the euro but has, for 
example, three years grace to phase out the country’s own 
currency) then the conversion must always be via the euro. 
The rate from each currency to the euro will be 
amalgamated to produce an overall conversion rate that is 
then used to convert the transaction amount.

Turnover (1.) The total sales figures for a company for a set period.
(2.) The rate at which stock is sold and replaced.
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U
Unique Reference Number 
(URN) The unique reference number assigned to a complete 

transaction to assist in tracing the progress of the transaction 
through Sage 200. This number is 12 digits long and 
comprises of: 3 digits for the user number, 2 digits for the 
source module in which the transaction was created, and a 7 
digit sequential reference number.

Unit of Measure The quantity in which a stock item is measured for purchase, 
sale or storage. 

Unit Price The price paid per unit of item purchased, or charged per 
unit of item sold.

Unpresented Cheques Cheques paid out, which are passing through the bank 
clearing system, but have not yet been presented to the bank 
where the account is maintained.

Unquoted Investments Investments not dealt in on a recognised stock exchange.

V
Valuation Formal assessment of worth, for example, valuation of 

property.

VAT Value Added Tax is applied to sales and purchase 
transactions in certain circumstances. These circumstances 
are described in the Sage 200 Accounting System Manager 
documentation.

VAT Invoice An invoice issued by a supplier registered for VAT showing 
the supplier’s VAT registration number, the date of issue 
and the tax point.

VAT Outputs and Inputs The HM Revenue and Customs department requires all 
businesses registered for VAT to account to them for all 
amounts of VAT charged on invoices (outputs) net of 
amounts incurred on purchase invoices (inputs).

VAT Receipt A receipt showing the amount of VAT as a separate item, 
together with the issuer's VAT registration number.
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VAT Registration Number All businesses registered for VAT are given a registration 
number. This number must be printed on all invoices.

VAT Return The form on which input and output VAT is declared to HM 
Revenue and Customs or your local tax authority.

VAT Tax Point The date on which VAT eligible sales are completed.

W
Waiting Postings Transactions that have not yet been posted to the Nominal 

Ledger. These can be updated using the Nominal Ledger 
'Update Waiting Postings' routine.

Warehouse Primary location point where a stock item is stored. The 
warehouse is the default primary location provided with 
Sage 200 when using multiple locations.

Working Capital The excess of current assets less current liabilities.

Write Off (1.) To cancel a bad debt or obsolete asset from accounts.
(2.) To consider a transaction as a loss or set off (a loss) 
against revenues.
(3.) To depreciate an asset by periodic charges. 
(4.) To charge a specified amount against gross profits as 
depreciation of an asset.

X
XML Extensible Markup Language file format. Sage 200 can 

import and export data in the XML file format. 

Y
Yield The annual income provided by an investment.

Z
Zero Rated Denoting goods on which the buyer pays no VAT (tax) 

although the seller can claim back any VAT (tax) paid.

cash book manual.book  Page 149  Tuesday, February 19, 2008  11:02 AM



Sage 200 Cash Book

150

cash book manual.book  Page 150  Tuesday, February 19, 2008  11:02 AM



9
Appendix: e-Banking Options

This appendix supplements the information provided for 
electronic bank reconciliation. For more information see 
Reconcile electronic bank statement on page 95.

Some e-Banking options can be changed if they do not 
match your needs. This appendix explains what options 
are available and how to change them.

In this appendix

Set the matching 
facility

Set a discard date
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Set the matching facility

You can:

● Control how the matching process works for automatic and 
manual matching.

● Set the Reconciliation routine to skip the need to confirm 
matched transactions.

Access the window

Choose Period End Routines > Bank Reconciliation and access the 
bank account enabled for e-banking. From the Reconciliation form 
menu select Tools > Options.
          

Enter the details

● Select the required 'Match Mode'.

● 'Match each Bank transaction to transactions in the Sage list'

Each transaction in the bank statement is selected in turn 
and the Sage statement is searched for matching 
transactions. This is the default setting.

● 'Match each Sage transaction to transactions in the Bank list'

Each transaction in the Sage statement is selected in turn 
and the bank statement is searched for matching 
transactions.
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● Select how you want the routine to deal with manual matches.

● To skip the confirmation stage of reconciliation ensure the 'Automatically confirm 
Manual Matches' check box is selected. 

● If you want to confirm manually, clear the 'Automatically confirm Manual Matches' 
check box.

Set a discard date

By setting a discard date, you stop transactions prior to a specified date being displayed in the 
reconciliation window. 

You can also set the routine to delete the transactions as they are imported from the bank file.

Access the window

Choose Period End Routines > Bank Reconciliation and access the bank account enabled for e-
banking. From the 'Reconciliation' form menu select Tools > Set Discard Date.
          

Enter the details

● Enter the required date. All transactions dated before the discard date will not appear in the 
bank transactions list when the bank file is imported.

● To delete all bank transactions before the discard date select the 'Delete Discarded Data' 
check box.
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A

Account
amending 36
creating 21
deleting 38
enquiry 105
planning 20
querying 105
reconciling 91
reporting 110
revaluing 83

Account Currency 23
Account Description 22
Account Details Report 110
Account Record 19
Account Reference 22
Account Type

current 23
deposit 23

Allocating
see Purchase Ledger User Guide
see Sales Ledger User Guide

Amending
account 36
direct debits 44
standing orders 44

Assigning
account currency 23
account description 22
account reference 22

B

Balance
verifying 115

Balancing
ledger 115

Bank Account Record 19

Bank Charges
nominal analysis 23, 30

Bank Statement
reconciling electronic bank 

statement 95
reconciling printed statement 91

Bank Transfer 62, 78

C

Cash Book Integration 6
Cash Book Settings 15
Creating

accounts 21
direct debits 41
standing orders 41

Current Account Type 23
Customer

payment, entering 51
payment, entering, foreign currency 70
receipt, entering 50
receipt, entering, foreign currency 70

D

Default Bank Account 13
Defaults

default bank account 13
Deleting

accounts 38
direct debits 46
imported electronic transactions 103
reconciled transactions 111
standing orders 46

Deposit Account Type 23
Direct Debits

amending 44
creating 41
deleting 46
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enquiry 108
managing 40
processing 90
reporting 108

E

Electronic Banking
amending imported transactions 102
deleting imported transactions 103
importing transactions 97
reconciling 95

Entering
customer payment 51
customer payment, foreign currency 70
customer receipt 50
customer transactions 50–52
customer transactions, foreign 

currency 70
inter account transfer 62
multiple items 59
nominal payment 56
nominal receipt 56
opening balances 32
over payment 54
purchase payment 53
purchase payment, foreign currency 66
purchase receipt 54
sales payment 51
sales payment, foreign currency 70
sales receipt 50
supplier payment 53
supplier payment, foreign currency 66
supplier receipt 54
supplier transactions 53–55
supplier transactions, foreign 

currency 66
void cheque 54

Exchange Rates
managing 83

F

Foreign Bank Revaluation 83
Foreign Currency

customer payment 70
customer receipt 70
entering multiple items 80
inter account transfer 78
nominal payment 74
nominal receipt 74
purchase payment 66
purchase receipt 66
sales payment 70
sales receipt 70
supplier payment 66
supplier receipt 66

G

Gain on Exchange 83
Grouped Transactions

entering 59
entering foreign currency 80

H

Housekeeping
period end 115
year end 116

I

Importing
electronic bank statement 97

Integrating with
nominal ledger 6
purchase ledger 6
sales ledger 6

Inter Account Transfer
entering 62
foreign currency 78
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L

Ledger
balancing 115

Loss on Exchange 83

M

Managing
accounts 87–111
direct debits 40
exchange rates 83
pending transactions 89
postings 89
standing orders 40

Multiple Item Entry
foreign currency 80

N

Nominal Default Accounts 23
Nominal Ledger

integration 6
Nominal Payment

entering 56
entering, foreign currency 74

Nominal Receipt
entering 56
entering, foreign currency 74

O

Opening Balances
book opening balance 33–35
correcting 35
entering 32
reconciled opening balance 34

Over Payment
entering receipt 54

P

Pending Transactions
managing 89
viewing 89

Performing
period end 115
year end 116

Period End
performing 115

Planning Cash Book Setup 13
Postings

managing 89
Processing

direct debits 90
standing orders 90

Purchase Ledger Integration 6
Purchase Payment

entering 53
entering, foreign currency 66

Purchase Receipt
entering 54

Q

Querying
account level 105
direct debits 108
standing orders 108
transaction level 107

R

Reconcile Bank Statement
electronic 95
printed 91

Recording
customer payment 51
customer payment, foreign currency 70
customer receipt 50
customer receipt, foreign currency 70
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customer transactions 50–52
customer transactions, foreign 

currency 70
inter account transfer 62
multiple items 59
nominal payment 56
nominal receipt 56
opening balances 32
over payment 54
purchase payment 53
purchase payment, foreign currency 66
purchase receipt 54
purchase receipt, foreign currency 66
sales payment 51
sales payment, foreign currency 70
sales receipt 50
sales receipt, foreign currency 70
supplier payment 53
supplier payment, foreign currency 66
supplier receipt 54
supplier receipt, foreign currency 66
supplier transactions 53–55
supplier transactions, foreign 

currency 66
void cheque 54

Reporting
account details 110
direct debits and standing orders 108
transaction listing 110
unpresented cheques 110

Revaluing
foreign bank accounts 83

S

Sales Ledger Integration 6
Sales Payment

entering 51
entering, foreign currency 70

Sales Receipt
entering 50
entering, foreign currency 70

Setting
direct debits 41
standing orders 41

Setting up Cash Book
checklist 13
planning 13
process 14

Settings
Cash Book 15

Setup
checklist 13
process 14

Standing Orders
amending 44
creating 41
deleting 46
enquiry 108
managing 40
processing 90
reporting 108

Supplier
payment, entering 53
payment, entering, foreign currency 66
receipt, entering 54
receipt, entering, foreign currency 66

System Integration 6

T

Transaction Listing Report 110
Transaction Types

customer payment 51
customer payment, foreign currency 70
customer receipt 50
customer receipt, foreign currency 70
inter account transfer 62
inter account transfer, foreign 

currency 78
nominal payment 56
nominal payment, foreign currency 74
nominal receipt 56
nominal receipt, foreign currency 74
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purchase payment, foreign currency 66
purchase receipt 54
sales payment 51
sales payment, foreign currency 70
sales receipt 50
sales receipt, foreign currency 70
supplier payment 53
supplier payment, foreign currency 66
supplier receipt 54

Transactions
customer transactions 50–52
deleting reconciled 111
enquiry 107
entering multiple items 59
multiple items, foreign currency 80
supplier transactions 53–55

U,V

Unpresented Cheques Report 110
VAT Return

see Nominal Ledger User Guide
Verifying

ledger balance 115
Viewing

Cash Book settings 15
pending postings 89
pending transactions 89

Void Cheque
entering 54

Y

Year End
performing 116
preparing for 116
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